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1 Foreword
The DriveControlSuite commissioning software for STOBER 6th generation drive controllers offers convenient functions for
efficient project configuration and commissioning of drive controllers in multi-axis and single-axis applications.

The PROFIdrive application included in the software contains various application classes for controller and drive-based
motion profiles. Jog mode is available in all application classes for commissioning, emergency operation,and maintenance
or repair work.

This documentation describes the general functions of the PROFIdrive application and guides you step by step through the
setup and project configuration of your drive project in the individual application classes.
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2 User information
This documentation supports you during the setup and project configuration of your drive system with the PROFIdrive
application, which is based on the internationally standardized PROFIdrive drive profile for electric drives in accordance
with IEC 61800-7-303 (version 4.2).

Commissioning is described using examples of a PROFINET network with STOBER 6th generation drive controllers in
combination with a Siemens AG controller.

Technical knowledge

To be able to commission one or more drive controllers in combination with a controller using the PROFIdrive application,
you should have basic knowledge of handling 6th generation STOBER drive controllers and of the DriveControlSuite
commissioning software. Operating your PROFINET network requires being familiar with PROFINET network technology and
the basics of the associated Siemens SIMATIC automation systems.

Technical requirements

Before you begin operating your PROFINET network, you need to wire the drive controllers and initially check that they are
functioning correctly. To do this, follow the instructions in the manual for the relevant drive controller.

2.1 Storage and transfer
As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product
This documentation is binding for:

SC6 or SI6 series drive controllers in conjunction with the DriveControlSuite software (DS6) in V 6.5-F or higher and
associated firmware in V 6.5-F-PN or higher.

2.3 Timeliness
Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.4 Original language
The original language of this documentation is German; all other language versions are derived from the original language.

2.5 Limitation of liability
This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

http://www.stoeber.de/en/downloads/
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2.6 Formatting conventions
Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.6.1 Display of safety instructions
Safety instructions are identified with the following symbols. They indicate special risks when handling the product and are
accompanied by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations
for efficient, error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

▪ if the stated precautionary measures are not taken.

CAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

▪ if the stated precautionary measures are not taken.

WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.6.2 Markup of text elements
Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning

Interpolated position mode Optional: File or product name or other name

Detailed information Internal cross-reference

http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu 
Settings

Window names, dialog box names, page names or buttons, combined
proper nouns, functions referenced by the interface

Select 
Referencing method A

Predefined entry

Save your 
<own IP address>

User-defined entry

EVENT 52: 
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, shortcut

Table > Insert table Navigation to menus/submenus (path specification)

2.6.3 Mathematics and formulas
The following signs are used to represent mathematical relationships and formulas.

- Subtraction

+ Addition

× Multiplication

÷ Division

| | Absolute value

http://www.stoeber.de
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2.7 Trademarks
The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

EnDat® EnDat® and the EnDat® logo are registered trademarks of Dr. Johannes Heidenhain
GmbH, Traunreut, Germany.

HIPERFACE® HIPERFACE® and the HIPERFACE DSL® logo are registered trademarks of SICK
STEGMANN GmbH, Donaueschingen, Germany.

PLCopen® PLCopen® is a registered trademark of the PLCopen Organisation, Gorinchem,
Netherlands.

PROFIBUS®, 
PROFINET®

PROFIBUS® and PROFINET® are registered trademarks of PROFIBUS
Nutzerorganisation e.V., Karlsruhe, Germany.

PROFIdrive®,
PROFIsafe®

PROFIdrive® and PROFIsafe® are registered trademarks of Siemens AG, Munich,
Germany.

SIMATIC®, 
TIA Portal®

SIMATIC® and TIA Portal® are registered trademarks of Siemens AG, Munich,
Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.

2.8 Explanation of terms
As relevant standards and products of other manufacturers are referenced, different manufacturer- or standard-specific
names are used for the same term in this documentation.

For improved understandability, the names in this documentation are standardized to the terminology of STOBER to the
greatest extent possible. The correlation of STOBER names to other sources can be found in the following table.

STOBER PROFINET

Controller IO controller

Drive controller IO device

Tab. 1: Correlation of STOBER terminology to PROFINET

STOBER PROFIdrive

Motion block operating mode Program mode

Command operating mode MDI mode

Referencing Homing

Jog Jogging

Tab. 2: Correlation of STOBER terminology to PROFIdrive
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3 What you should know before commissioning
The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

3.1 Program interfaces
The following chapters include an overview of the program interfaces for the described software components.

3.1.1 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

1 2

3

4

5

6 7 8
9

Fig. 1: DS6: Program interface
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No. Area Description

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in
the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter
lists

You can use variable parameter lists to compile any parameters in individual parameter
lists for a quick overview.

9 Status bar In the status bar, you can find the specifications of the software version and get additional
information about the project file, the devices and the progress of the process during
processes such as loading projects.

3.1.1.1 Configuring the view

In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to optimize the available
space in the workspace when working with smaller screens.

Showing/hiding areas

Use the icons in the toolbar or the items in the View menu to show or hide specific areas in DriveControlSuite as needed.

Icon Item Description

– Reset Resets the view to factory settings.

Project Shows/hides the Project window (project tree, project
menu).

Messages Shows/hides the Messages window.

Parameter check Shows/hides the Parameter check window.

Variable parameter lists Shows/hides the Variable parameter lists window.
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Arrange and group areas

You can undock and rearrange the individual areas via drag and drop. If you drag an undocked window to the edge of
DriveControlSuite, you can release it there in a color-highlighted area either next to or on top of another window to redock
it.

When you release the window onto another window, the two areas are merged into one window where you can use tabs to
switch between the areas.

3.1.1.2 Navigation using sensitive circuit diagrams

Fig. 2: DriveControlSuite: Navigation using text links and symbols

In order to illustrate graphically the processing sequence of actual and set values, the use of signals or certain drive
component arrangements and to make configuring the accompanying parameters easier, they are displayed on the
respective wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a
result, allow you to reach additional helpful detail pages with just a click.
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3.1.2 TIA Portal program interface
The Siemens Totally Integrated Automation Portal (TIA Portal) offers a platform you can use to commission your PROFINET
system. The TIA Portal is broken down into the portal view and the project view.

TIA portal view

The TIA overall functionality is broken down into different task areas that you can reach using portals. The following graphic
shows the interface elements of the TIA portal view relevant to this documentation.

1 2

3

Fig. 3: TIA Portal: Program interface of the portal view

No. Area Description

1 Portal selection The portal selection offers you access to various portals for different tasks and functions.

2 Portal functions Depending on the selected portal, the portal functions are available here.

3 Project view The button lets you change to the project view.
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TIA project view

The TIA project view offers you access to all components of a project. The following graphic shows the interface elements of
the TIA portal view relevant to this documentation.

1

2

3

4

5

6

Fig. 4: TIA Portal: Program interface of the project view

No. Area Description

1 Project navigation Project navigation offers you access to all components of your TIA project.

2 Detail view The detail view shows you additional information about a selected object.

3 Workspace In the workspace, you can edit objects in the topology view, network view or device view,
for example.

4 Inspector window The inspector window shows you additional information about a selected object.

5 Task cards Task cards are available depending on the selected object and grant you access to the
hardware catalog, online tools, tasks or libraries, for example.

6 Portal view The button lets you change to the portal view.
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3.2 Meaning of parameters
You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,
etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a
coordinate or the combination of coordinate and name.

E50 V0

Coordinate Name Version

Drive controller G6

Drive controller
generation/series

3.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The 6th generation of STOBER drive controllers differentiates
between the following parameter groups.

Group Topic

A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake

G Technology – Part 1 (application-dependent)

H Encoder

I Motion (all motion settings)

J Motion blocks

K Control panel

L Technology – Part 2 (application-dependent)

M Profiles (application-dependent)

N Additional functions (application-dependent; e.g. extended cam control unit)

P Customer-specific parameters (programming)

Q Customer-specific parameters, instance-dependent (programming)

R Production data for the drive controller, motor, brakes, motor adapter, gear unit and geared motor

S Safety (safety technology)

T Scope

U Protection functions

Z Fault counter

Tab. 3: Parameter groups
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3.2.2 Parameter types and data types
In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The
data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,
data types and their value range can be found in the following table.

Data type Parameter type Length Value range (decimal)

INT8 Integer or selection 1 byte (signed) -128 – 127

INT16 Integer 2 bytes (1 word, signed) -32768 – 32767

INT32 Integer or position 4 bytes (1 double word,
signed)

-2147483648 – 2147483647

BOOL Binary number 1 bit (internal: 
LSB in 1 byte)

0, 1

BYTE Binary number 1 byte (unsigned) 0 – 255

WORD Binary number 2 bytes (1 word, unsigned) 0 – 65535

DWORD Binary number or parameter
address

4 bytes (1 double word,
unsigned)

0 – 4294967295

REAL32
(single type according to
IEE754)

Floating-point number 4 bytes (1 double word,
signed)

-3.40282 × 1038 – 3.40282 ×
1038

STR8 Text 8 characters —

STR16 Text 16 characters —

STR80 Text 80 characters —

Tab. 4: Parameters: data types, parameter types, possible values

Parameter types: Use

§ Integer, floating-point number
For general computing processes
Example: Set and actual values

§ Selection
Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

§ Binary number
Bit-oriented parameter information that is collected in binary
Example: Control and status words

§ Position
Integer combined with associated units and decimal places
Example: Actual and set values of positions

§ Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units
Example: Actual and set values for velocity, acceleration, deceleration, jerk

§ Parameter address
Referencing of a parameter
Example: In F40 AO1 source, for example, E08 n-motor filtered can be parameterized

§ Text
Outputs or messages
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3.2.3 Parameter types
The following types of parameters are differentiated.

Parameter type Description Example

Simple parameters Consist of one group and one line with a
defined value.

A21 Brake resistor R: Value = 100 ohms

Array parameters Consist of a group, a line and multiple
sequential (listed) elements, which have the
same properties but different values.

A10 Access level

§ A10[0] access level: Value = Access level
via operating unit

§ A10[2] access level: Value = Access level
via CANopen and EtherCAT

§ A10[4] access level: Value = Access level
via PROFINET

Record parameters Consist of a group, a line and multiple
sequential (listed) elements, which can have
different properties and different values.

A00 Save values

§ A00[0] Start: Value = Start action

§ A00[1] Progress: Value = Display action
progress

§ A00[2] Result: Value = Display action
result

Tab. 5: Parameter types

3.2.4 Parameter structure
Every parameter has specific coordinates with the following structure.

E250 [2] .3

Axis
Group

Line

1.

Element
Bit

§ Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters (value range: 
1 – 4).

§ Group
The thematic group to which a parameter belongs (value range: A – Z).

§ Line
Distinguishes the parameters within a parameter group (value range: 0 – 999).

§ Element (optional)
Elements of an array or record parameter (value range: 0 – 16000).

§ Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 – 31).
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3.2.5 Parameter visibility
The visibility of a parameter is primarily controlled by the access level you set in DriveControlSuite and by the properties
you project for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or
hidden depending on other parameters or settings. For example, the parameters of an additional function are only shown
as soon as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has 2 access levels: the access level for read access (visibility) and the access level for write access
(editability). The following levels are present:

§ Level 0
Elementary parameters

§ Level 1
Important parameters of an application

§ Level 2
Important parameters for service with extensive diagnostic options

§ Level 3
All parameters needed for commissioning and optimizing an application

The parameter A10 Access level controls general access to parameters:

§ Over CANopen or EtherCAT (A10[2])

§ Over PROFINET (A10[3])

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during communication via fieldbus.

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

Firmware

Due to the further development and updating of functions for the 6th generation of STOBER drive controllers, new
parameters and also new versions of existing parameters are continuously being implemented in DriveControlSuite and in
the firmware. The parameters are displayed in the software according to the DriveControlSuite version used and the
configured firmware version of the respective drive controller.

Applications

Applications generally differ in terms of functions and their control. For this reason, different parameters are available with
each application.
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3.3 Signal sources and process data mapping
The transmission of control signals and set values in DriveControlSuite meets the following principles.

Signal sources

Drive controllers are controlled either over a fieldbus, using mixed operation consisting of a fieldbus system and terminals
or exclusively using terminals. 
You can use the corresponding selection parameters, referred to as signal sources, to configure whether the control signals
and set values of the application are obtained over a fieldbus or using terminals.

In case of activation over a fieldbus, parameters that are selected as data sources for control signals or set values must be
part of the subsequent process data mapping. In the case of activation using terminals, the respective analog or digital
inputs are specified directly.

Process data mapping

In the PROFIdrive application, the process data mapping is specified by the controller as soon as you establish an online
connection between the controller and the drive controller. It is not necessary to manually assign the process data channels
for transmission of the receive and transmit process data in DriveControlSuite.

3.4 Power-failure-proof storage
All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are not yet stored in non-volatile memory.

Saving to a drive controller

You have the following options for saving the configuration to a drive controller in non-volatile memory:

§ Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values action

§ Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A00 Save values: Set the parameter
A00[0] to the value 1: Active

Saving to all drive controllers within a project

You have the following options for saving the configuration to multiple drive controllers in non-volatile memory:

§ Saving the configuration using the toolbar:
Toolbar > Save values symbol: Click on the Save values symbol

§ Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller starts without an executable configuration when it is next switched on. In this case, the configuration must
be transferred to the drive controller again and saved in non-volatile memory.
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4 Commissioning
The following chapters describe the commissioning of a PROFINET network, consisting of a controller from Siemens and
multiple drive controllers from STOBER, with the help of STOBER DriveControlSuite and the Siemens TIA Portal.

We assume the following system environment as an example so that you can better follow the individual commissioning
steps:

§ Drive controllers from the SC6 or SI6 series with firmware version V 6.5-F-PN or later

§ DriveControlSuite commissioning software in version 6.5-F or later

in combination with

§ Siemens SIMATIC S7-1500 controller

§ Siemens Totally Integrated Automation Portal (TIA Portal) automation software in V16 or later

Commissioning is divided into the following steps:

1. First, define how the drive controllers are to be controlled.

2. DriveControlSuite:
After that, project all drive controllers (device control and application), parameterize the general PROFINET settings,
the required limits as well as the motor, then transfer your configuration to the drive controllers of your PROFINET
network.

3. TIA Portal:
Next, map your real PROFINET network in TIA Portal, configure the individual nodes and parameterize the control of
the drive controllers. Transfer the configuration to the controller and start up your PROFINET network.

Information

Before you start commissioning your PROFINET network using DriveControlSuite and TIA Portal, you must network all nodes
of your PROFINET network with each other.

Detailed information about using and commissioning the optional safety technology via PROFINET (PROFIsafe) or via
terminals can be found in the corresponding manual (see Further information [} 108]).
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4.1 Setting the control
The options described below are available for controlling STOBER drive controllers via the TIA Portal.

Siemens function blocks (FB) from the DriveLib

Function block Description Application

FB SINA_SPEED Control of a speed-controlled axis Drive-based application

FB SINA_POS Control of a position-controlled axis Drive-based application

Tab. 6: Siemens function blocks DriveLib

The function blocks can be downloaded free of charge from the Siemens website and imported into the TIA Portal (https://
support.industry.siemens.com, search term: Drive_Lib_S7_1200_1500). If you are already using the function blocks in
TIA Portal, make sure that you are working with the latest version.

Siemens technology objects (TO)

Technology object Description Application

TO_SpeedAxis Control of a speed-controlled axis Controller-based application

TO_PositioningAxis,
TO_SynchronousAxis

Control of a position-controlled axis Controller-based application

TO_BasicPos Control of a position-controlled axis Drive-based application

Tab. 7: Siemens technology objects

You can access the technology objects directly in TIA Portal and add them to your controller.

Possible combinations

The following table shows an overview of the possible combinations of function blocks or technology objects with the
available application classes and telegrams.

Control Application class Telegrams

FB SINA_SPEED AC1 Standard telegram 1

FB SINA_POS AC3 Siemens telegram 111

TO_SpeedAxis AC1 Standard telegrams 1, 2, 3

TO_PositioningAxis,
TO_SynchronousAxis

AC4 Standard telegram 3

TO_BasicPos AC3 Siemens telegram 111

Tab. 8: Combinations: function block or technology object with telegram

During commissioning in the TIA Portal, you will learn how to configure your control system.

Information

This documentation focuses on the device-specific settings that must be considered for drive controllers from STOBER for
controlling Siemens function blocks or parameterizing technology objects. For settings that are not described in detail, refer
to the Siemens documentation.

https://support.industry.siemens.com
https://support.industry.siemens.com
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4.2 DS6: Configuring the drive controller
Project and configure all drive controllers for your drive system in DriveControlSuite (see also DS6 program interface [} 10]).

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

4.2.1 Initiating the project
In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

4.2.1.1 Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

Creating a new project

1. Start DriveControlSuite.

2. On the start screen, click Create new project.

ð The new project is created and the configuration dialog for the first drive controller opens.

ð The Drive controller button is active.

Projecting the drive controller

1. Properties tab: 
Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the drive controller.
Designation: Give the drive controller a unique name.
Version: Version your project configuration.
Description: If necessary, specify additional supporting information, such as the change history of the project
configuration.

2. Drive controller tab:
Select the series and device type of the drive controller.
Firmware: Select the PROFINET version 6.x -PN.

3. Option modules tab:
Safety module: If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:
Device control: Select the PROFIdrive device control.
Rx process data, Tx process data: Select PROFINET Rx and PROFINET Tx for transmitting PROFINET process data.
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Projecting the axis

1. Click on Axis 1.

2. Properties tab: 
Establish the connection between your circuit diagram and the axis to be projected in DriveControlSuite.
Reference: Specify the reference code (equipment code) of the axis.
Designation: Give the axis a unique name.
Version: Version your project configuration.
Description: If necessary, specify additional supporting information, such as the change history of the project
configuration.

3. Application tab: 
Select PROFIdrive.

4. Motor tab: 
Select the type of motor operated using this axis. If you are working with motors from third-party suppliers, enter the
accompanying motor data at a later time.

5. Repeat steps 2 – 4 for the 2nd axis (only for double-axis controllers).

6. Confirm with OK.

4.2.1.2 Configuring safety technology

If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the
commissioning steps outlined in the corresponding manual in the next step.

4.2.2 Parameterizing general PROFINET settings

ü You have projected the PROFINET Rx and PROFINET Tx process data for the drive controller.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the Project menu >
Wizard area.

2. Select the PROFINET wizard.

3. A100 Fieldbus scaling:
Leave the default value at 1: Native (values are passed unchanged).

4. A273 PN device name:
Shows the PROFINET device name that was assigned in TIA Portal if there is an online connection between the drive
controller and controller. Alternatively, you can assign the device name for use in PROFINET. To do this, enter the
desired device name both in A273[0] and in A273[3]. If you do this, you do not have to search for the nodes in the
TIA Portal to be able to assign names there.

5. A109 PZD-Timeout:
Define the time that results from the tolerated failure time for monitoring the PZD communication plus the watchdog
time of the controller (TIA Portal: watchdog time) in the PROFINET network (default value: 20 ms).

4.2.3 Configuring PZD transmission
The PZD channel (process data transmission channel) serves to transfer control and status information as well as actual and
set values between a controller (IO controller) and drive controller (IO device) cyclically in real time.

The direction of data flow is important in this data exchange. From the perspective of the drive controller, PROFINET IO
system distinguishes between receive PZD (RxPZD) and transmit PZD (TxPZD). STOBER drive controllers of the 6th
generation support a flexible assignment of the parameter values to be transmitted.

In the PROFIdrive application, the mapping of the process data is specified by the controller in online operation.
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4.2.4  Parameterizing the STOBER motor
You have projected one of the following motors:

STOBER synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. All additional data on the brake and
encoder is transferred at the same time.

STOBER Lean motor without encoder (with optional brake)

By projecting the corresponding motor, limiting values for currents and torques as well as associated temperature data are
automatically transferred to the respective parameters of the individual wizards. You only have to parameterize the cable
length in use. Even the brake purging and engaging times are already stored. You just have to activate the brake.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the Project menu >
Wizard area.

2. Select the Motor wizard.

3. B101 Cable length:
Select the cable length of the power cable in use.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).

Then activate the brake.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the Project menu >
Wizard area.

2. Select the Brake wizard.

3. F00 Brake:
Select 1: Active.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).

Motor protection

All models of the 6th STOBER drive controller generation feature an i²t model ─ a computational model for thermal
monitoring of the motor. To activate it and set up the protective function, configure the following settings (deviating from
the presets): U10 = 2: Warning and U11 = 1.00 s. This model can be used instead of or in addition to temperature-
monitored motor protection.
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4.2.5 Mapping the mechanical axis model
For a control in combination with telegram 111, you must map your complete mechanical environment in DriveControlSuite
to be able to commission your real drive train with one or more drive controllers. For all other telegrams, this step is
optional. In this case, parameterize the required limits (see Parameterizing limits [} 29]).

4.2.5.1 Parameterizing the axis model

Parameterize the setup of your drive in this order:

§ Define the axis model

§ Scale the axis

§ Parameterize the position and velocity window

§ Limit the axis (optional)

• Limit the position

• Limit the velocity, acceleration and jerk

• Limit the torque and force

Information

If you are using a double-axis controller with two projected axes, you must parameterize the axis model for each axis
individually.

4.2.5.1.1 Define the axis model

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the project menu >
Wizard area.

2. Select the Axis model wizard.

3. I05 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places individually for specifying
and displaying position set values, velocities, accelerations and jerk, select 0: User defined, rotational or 
1: User defined, translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying position set values,
velocities, accelerations and jerk are to be fixed, select 2: Rotational or 3: Translational.

4. B26 Motor encoder:
Define the interface to which the motor encoder is connected.

5. I02 Position encoder (optional):
Define the interface to which the position encoder is connected.

6. I00 Position range:
Define whether the travel range of the axis is limited or endless (modulo).

7. If you have selected 1: Endless for I00, parameterize a revolution length (see Scale the axis [} 27]).
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Information

When you parameterize I05 Type of axis, you can either use the selection 0: User defined, rotational or 1: User defined,
translational to configure units of measure and the number of decimal places for the axis model individually or use the
selections 2: Rotational and 3: Translational to revert to preset values.

Selection 0: User defined, rotational and selection 1: User defined, translational let you configure the unit of measure (I09)
and the decimal places (I06) individually. Velocity, acceleration and jerk are represented as the derivative of the unit of
measure with respect to time.

Selection 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in
rad/s2, jerk in rad/s3.

Selection 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,
acceleration in m/s2, jerk in m/s3.

Information

If you do not parameterize it differently for I02 Position encoder, B26 Motor encoder is used for position control as
standard.
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4.2.5.1.2 Scale the axis

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of positions, velocities,
accelerations, torque/force, which calculates the effects of changed motion variables on the entire system.

4. I01 Circular length:
If you have selected 1: Endless for I00 Position range, enter the revolution length.

5. I06 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
number of decimal places.

6. I09 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
unit of measure.

Information

A change to parameter I06 moves the decimal separator for all axis-specific values!
Ideally, change I06 before parameterizing other axis-specific values and then check them afterwards.

Information

Parameter I297 Maximum speed position encoder must be parameterized according to your application case. If I297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if I297 is set too
high, measuring errors of the encoder can be overlooked.

I297 depends on the following parameters: I05 Type of axis, I06 Decimal places position, I09 Measure unit as well as
I07 Distance factor numerator position and I08 Distance factor denominator position for Drive Based or PROFIdrive or
A585 Feed constant for CiA 402. If you have made changes to one of the parameters listed, select I297 accordingly as well.

4.2.5.1.3 Parameterizing the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or
velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window: 
Parameterize a tolerance range for velocity tests.

3. I22 Target window: 
Parameterize a tolerance range for position tests.

4. I87 Actual position in window time:
Parameterize how long a drive must stay in the specified position window before a corresponding status message is
output.

5. I21 Maximal following error
Parameterize a tolerance range for lag tests.
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4.2.5.1.4 Limiting the axis

If necessary, limit the movement variables for position, velocity, acceleration, jerk as well as torque/force according to the
applicable conditions for your axis model.

Limiting the position (optional)

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Limit: Position.

3. If necessary, limit the position of your axis using a software or hardware limit switch to secure the travel range.

Limiting velocity, acceleration, jerk (optional)

The default values are designed for slow velocities without gear units. For this reason, adapt the saved values.

For example, verify the maximum velocity of the motor (B83) against the velocity of the output (I10).

1. Select the Motor wizard.

2. Determine the maximum possible motor velocity in parameter B83 v-max motor.

3. Select the Axis model wizard > Axis: Scaling > Conversion of positions, velocities, accelerations, torque/force area.

4. Velocity line: 
Enter the maximum motor velocity from B83 in the Velocity line of the Motor column and confirm with ENTER.

ð The maximum velocity of the motor has been transferred to the output.

5. Repeat the procedure for other limits, such as for the gear unit input speed (C11).

6. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

7. I10 Maximal speed: 
Limit the maximum velocity of the output, taking into account the determined system limits and the maximum motor
velocity B83.

8. Determine the limiting values for acceleration and jerk if necessary and enter them into the associated parameters.

Limiting torque/force (optional)

The default values take into account the rated operation together with the overload reserves.

1. Select the Axis model wizard > Limit: Torque/force.

2. If the motor force must be limited, adapt the saved values as necessary.
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4.2.6 Parameterizing limits
Limit the motion variables velocity, acceleration and jerk and define the quick stop deceleration according to the conditions
applicable to your application.

ü You have parameterized the general PROFINET settings.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

3. I10 Maximal speed: 
Limit the maximum velocity of the output.

4. I11 Maximal acceleration: 
Limit the maximum acceleration of the output.

5. I16 Maximal jerk: 
Limit the maximum jerk of the output.

6. I17 Quickstop deceleration: 
Limit the quick stop deceleration of the output.

7. Set the parameters for the 2nd axis also (only for double-axis controllers).

Then define the reference value for the target and actual velocities. For a control in combination with standard telegram 1,
2 or 3, the reference value is mandatory to ensure the function of the application. For a control in combination with
telegram 111, the reference value is not evaluated.

1. Mark the drive controller in the project tree and click in the Project menu > Parameter list area on the first projected
axis.

2. Group M > Parameter M571 Velocity reference value:
Define the reference value for the target and actual velocities.

3. Set the parameter for the 2nd axis also (only for double-axis controllers).

Information

When you set the corresponding parameters on the controller side during commissioning in TIA Portal, note that some
units on the drive controller and controller side may be different.

Parameter (DS6) Description Parameter (TIA Portal)

I10 Maximal speed Maximum permitted velocity ≤ I10

I11 Maximal acceleration Maximum permitted acceleration/deceleration
≤ I11

I16 Maximal jerk Maximum permitted jerk ≤ I16

I17 Quickstop deceleration Emergency deceleration ≤ I17

M571 Velocity reference value, reference value for
target and actual velocities

Reference speed = M571

Tab. 9: Required parameters on drive controller and controller sides
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4.2.7 Optional: Referencing the absolute position
When commissioning a system with position measurement systems, the relation of a measured to an actual axis position
must be determined.

For a control in combination with telegram 111, you must reference your drive if you are working with absolute positions.
For all other controls, this step is not necessary. In this case, transfer and save the configuration (see Transmitting and
saving the configuration [} 32]).

Information

If you are using a double-axis controller with two projected axes, you must reference the absolute position for each axis
individually.

4.2.7.1 Defining the referencing method

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the Project menu >
Wizard area.

2. Select the Referencing wizard.

3. I30 Referencing type, I31 Referencing direction, I35 Referencing with zero pulse:
For information on possible combinations of the named characteristics as well as detailed descriptions of the
individual referencing methods, see Referencing methods [} 62].

4. I43 Move to reference position:
If the axis is to automatically move to the referenced position after a reference run, set this parameter to 1: Active.

4.2.7.2 Parameterizing the reference switch

If you are working with absolute positions and would like to determine a reference position while referencing using the
reference switch, proceed as follows.

1. Select the PROFIdrive application wizard > Data sources > Application digital signals: Data source.

2. I103 Source reference switch:

2.1. If a digital input (direct or inverted) acts as the signal source, select the corresponding input.

2.2. If bit 3 of the control word I210 of the PROFIdrive application is the signal source, select 2: Parameter.
Bit 3 is thus defined as the source for the reference switch.
Note that individual bits of the control word are transmitted only if the control word is part of the process data
mapping.
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4.2.7.3 Setting the reference

If you are working with absolute positions and would like to reference without using a referencing run, the value of the
current actual position is applied directly as a parameter value from I34 using the Set reference signal.

1. Select the PROFIdrive application wizard > Data sources > Application digital signals: Data source.

2. I111 Source set reference:

2.1. If a digital input (direct or inverted) acts as the signal source, select the corresponding input.

2.2. If the control word I210 of the PROFIdrive application acts as the signal source, select 2: Parameter.
Bit 11 of the control word is set as a reference source.
Note that individual bits of the control word are transmitted only if the control word is part of the process data
mapping.

4.2.7.4 Parameterizing the limit switch

Using the limit switch, you can limit the travel range in the positive and negative direction using sensor signals, regardless of
the operating mode. Both signals are protected against wire breaks (= low active, i.e. a low level leads to a limit switch
fault).

Parameterizing a positive limit switch

1. Select the PROFIdrive application wizard > Data sources > Application digital signals: Data source.

2. I101 Source positive /limit switch:

2.1. If a digital input (direct or inverted) acts as the signal source, select the corresponding input.

2.2. If the control word I210 of the PROFIdrive application acts as the signal source, select 2: Parameter.
Bit 1 of the control word is set as a data source for the positive limit switch.
Note that individual bits of the control word are transmitted only if the control word is part of the process data
mapping.

Parameterizing a negative limit switch

1. Select the PROFIdrive application wizard > Data sources > Application digital signals: Data source.

2. I102 Source negative /limit switch:

2.1. If a digital input (direct or inverted) acts as the signal source, select the corresponding input.

2.2. If the control word I210 of the PROFIdrive application acts as the signal source, select 2: Parameter.
Bit 2 of the control word is set as a data source for the negative limit switch.
Note that individual bits of the control word are transmitted only if the control word is part of the process data
mapping.
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4.2.8 Transmitting and saving the configuration
In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Prerequisites for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

Transmitting the configuration

ü The drive controllers are switched on.

1. In the project tree, highlight the module under which you have recorded your drive controller and click Online
connection in the project menu.

ð The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab > IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the drive controller to which you would like to transfer the configuration. Change the selection of transmission
type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:
Click Establish online connections.

ð The configuration is transferred to the drive controllers.
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Saving a configuration

ü You have successfully transferred the configuration.

1. Online functions window:
Click Save values (A00).

ð The Save values (A00) window opens.

2. Click Start action.

ð The configuration is saved on the drive controllers in non-volatile memory.

3. Close the Save values (A00) window.

Information

For the configuration to take effect on the drive controller, a restart is required when the configuration is saved on the
drive controller for the first time or when changes are made to the firmware or process data mapping.

Restarting a drive controller

ü You have saved the configuration on the drive controller in non-volatile memory.

1. Online functions window:
Click Restart (A09).

ð The Restart (A09) window opens.

2. Select which of the connected drive controllers you want to restart.

3. Click Start action.

4. Confirm the safety instruction with OK.

ð The Restart (A09) window closes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð The selected drive controllers restart.
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4.2.9 Activating the control panel and testing the configuration

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

ü You have successfully saved the configuration.

ü There must not be any active safety function.

ü The drive controller is switched on and connected to the network.

ü There is an online connection between DriveControlSuite and the drive controller.

1. Highlight the relevant drive controller in the project tree and click on the first projected axis in the Project menu >
Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The drive is controlled using the activated control panel.

4. Move the axis step-by-step and test the direction of motion, velocity, distances, etc. using the Jog+, Jog−, Jog step+
and Jog step− buttons.

5. Optimize your project configuration based on your test results as necessary.

6. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog− cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in I14.

Jog+ and Jog− have a higher priority than Jog step+ and Jog step−.
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4.3 TIA Portal: Setting up a PROFINET network
A PROFINET networks generally consists of a controller (IO controller) and multiple drive controllers (IO devices). Using
TIA Portal, map your real PROFINET network in a TIA project, configure all PROFINET nodes and link them logically with each
other. Then, transfer the configuration to the controller and check the cyclical communication.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

4.3.1 Installing the GSD file
To be able to map the STOBER drive controllers of your PROFINET network in your TIA project, you must import and install a
GSD file (general station description file) from STOBER in your TIA project. STOBER drive controllers are available in the
hardware catalog of your TIA project as soon as the GSD file has been installed.

Information

If you have already downloaded a GSD file from the STOBER download area at an earlier point, make sure that you are using
the current version of the GSD file required.

ü You have downloaded the current version of the GSD file from the STOBER download area and saved it locally.

ü You have created a TIA project and are in the TIA project view.

1. In the menu bar, select Options > Manage general station description files (GSD).

ð The Manage general station description files window opens.

2. Installed GSDs tab, Source path area:
Select the directory in which you have stored the GSD file from STOBER and confirm with OK.

ð The GSD file is displayed in the Content of the imported path area.

3. Content of the imported path area:
Select the desired GSD file and click on Install.

ð The GSD file is installed; the STOBER drive controllers are available in the hardware catalog.
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4.3.2 Projecting the PROFINET network
Map the controller and all drive controllers of your PROFINET network in a TIA project by selecting the corresponding
modules from the hardware catalog and incorporating them into the project.

4.3.2.1 Projecting the controller

Project the controller of your PROFINET network.

ü You have created a TIA project and installed the GSD file from STOBER.

ü You are in the TIA network view; the hardware catalog is open.

1. Hardware catalog:
Select Controller > SIMATIC S7-1500 > CPU and open the folder of the CPU type that belongs to your controller.

2. Drag and drop the desired controller into the network view.

ð The controller is incorporated into your TIA project.

4.3.2.2 Optional: Projecting synchronized operation

For standard telegram 3, configure the following settings for clock synchronization via PROFINET IRT if you want to
implement control in application class 4. This step is omitted for standard telegram 3 in application class 1 and for other
combinations.

ü You have projected a controller.

ü You are in the TIA network view.

1. Network view:
Double-click on the controller of your PROFINET network.

ð This switches you to the respective device view; the Inspector window shows the device properties.

2. Inspector window > General tab:
Select PROFINET interface > Advanced options > Clock synchronization in the area navigation.
Clock synchronization for local modules area:
Clock synchronization: Activate the option.

ð You have projected synchronized operation.

4.3.2.3 Projecting the drive controller

Project all drive controllers of your PROFINET network.

ü You have created a TIA project and installed the STOBER-specific GSD.

ü You are in the TIA network view; the hardware catalog is open.

1. Hardware catalog: 
Select Other field devices > PROFINET IO > Drives > STOBER ANTRIEBSTECHNIK GmbH & Co. KG > STOBER
ANTRIEBSTECHNIK > STOBER 6th generation drive controllers > SI6, SC6 double-axis controllers+ PD2 or SI6, SC6
single-axis controllers + PD2.

2. Drag and drop the desired drive controller into the network view.

ð The drive controller is incorporated into your TIA project.

3. Repeat steps 1 and 2 for all drive controllers of your PROFINET network.
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Information

To be able to project the SU6 safety module and use PROFIsafe, you must project a PROFIsafe-capable drive controller. You
can identify a PROFIsafe-capable drive controller in the hardware catalog by the addition of + PROFIsafe or + PS in the
device name.

4.3.2.4 Linking the controller and drive controller logically

Establish a logical gate link between the controller and drive controllers in order to enable the communication between the
devices.

ü You are in the TIA network view.

ü You have projected the controller and drive controllers.

1. Click on the port of the controller and drag a connection to the port of the first drive controller while holding the
mouse button.

2. Repeat the process for all drive controllers of your PROFINET network.

ð The controller and drive controllers of your PROFINET network are linked logically with each other.

Information

To be able to link the controller and drive controllers with each other logically, you must be in the TIA network view.

4.3.3 Configuring the controller
Configure the network addresses for the controller as needed.

4.3.3.1 Configuring network addresses

As needed, you can change the IP address and subnet mask of the controller.

ü You are in the TIA network view.

1. Network view:
Double-click on the controller of your PROFINET network.

ð This switches you to the respective device view; the Inspector window shows the device properties.

2. General tab:
Select PROFINET interface > Ethernet addresses in the area navigation.

3. IP protocol area > Set IP address in the project:
If not set by default, activate this option and change the IP address and subnet mask of the controller.

ð The IP address and subnet mask of the controller are configured.
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4.3.4 Configuring the drive controller
Assign a device name for the drive controllers of your TIA project to be able to identify them in the PROFINET network.
Project a telegram for each axis and configure the settings for synchronization afterwards if necessary.

4.3.4.1 Assigning device names

Assign a device name for your drive controllers to be able to identify them in the PROFINET network.

ü You are in the TIA network view.

1. Network view:
Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the inspector window shows the device properties.

2. General tab:
Select General in the area navigation.

ð The general settings for the drive controller open.

3. Name:
Assign a device name for the drive controller that corresponds to the PROFINET naming conventions.

4. Device view: 
Mark the drive controller in question and select Assign device name using its context menu.

ð The Assign PROFINET device name window opens.

5. Click on Update list.

ð All drive controllers are listed that were found in the subnet.

ð Depending on the drive controller, the device type, IP address and MAC address are displayed.

6. Mark the drive controller that you would like to name and click on Assign name.

ð The device name is assigned to the selected drive controller.

Information

Using Flash LED, you can identify which drive controller you have currently selected if multiple drive controllers are found in
the same subnet.

As an alternative, you can identify the drive controller by its MAC address. The MAC address of the drive controller can be
read off in parameter A279 PN MAC addresses in DriveControlSuite (PROFINET wizard > Diagnostics).
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4.3.4.2 Projecting a standard telegram

Project one standard telegram per axis.

ü You are in the TIA network view; the hardware catalog is open.

1. Network view:
Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the Inspector window shows the device properties.

2. Hardware catalog > Module:
Select PROFIdrive module.

3. Drag and drop the module into the device overview of the drive controller at slot 1.

4. Hardware catalog > Module > Submodules:
Select a standard telegram.

5. Drag and drop the selected standard telegram into the device overview of the drive controller at slot 1 2.

6. If you are using a double-axis controller, repeat steps 2 – 5 for the second axis and slots 2 as well as 2 2.

4.3.4.3 Optional: Setting a drive controller synchronously

For standard telegram 3, configure the following settings for clock synchronization via PROFINET IRT if you want to
implement control in application class 4. This step is omitted for standard telegram 3 in application class 1 and for other
combinations.

ü You are in the TIA network view.

1. Network view:
Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the Inspector window shows the device properties.

2. Inspector window > General tab:
Select PROFINET interface > Advanced options > Clock synchronization in the area navigation.
Clock synchronization for local modules area:
Clock synchronization: Activate the option.

3. Detail overview area:
Activate the module with the inserted standard telegram 3 in the Clock synchronization column to assign the
synchronized operation to the telegram. If it is a double-axis controller, activate the 2nd module with the inserted
standard telegram 3.

ð The times are recalculated and entered in the Clock synchronization for local modules area. The transmission cycle
is taken from the GSD file.

ð You have configured the drive controller for synchronized operation.
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4.3.5 Configuring the control
The following chapters describe how to configure the control using 5 example combinations. Follow the description that
applies to your application.

4.3.5.1 FB SINA_SPEED and standard telegram 1

With the function block SINA_SPEED, you can implement the control of a speed-controlled axis. You can use this function
block with standard telegram 1.

Programming the control

Fig. 5: Function block SINA_SPEED

For communication with the drive controller, you need the hardware identifier of the standard telegram hardware
submodule on the controller side. The hardware identifier, 267 in this example, is displayed in the Inspector window >
System constants tab if you mark the standard telegram in the device overview of the workspace.

Store the address for the inputs HWIDSTW (transmitting side from controller view) and HWIDZSW (receiving side from
controller view).

Input Data type Required value

HWIDSTW HW_IO Hardware identifier of the standard telegram hardware
submodule

HWIDZSW HW_IO Hardware identifier of the standard telegram hardware
submodule

Tab. 10: Function block SINA_SPEED: Required values

For further information about the control of the function block, see the DriveLib documentation from Siemens.

Testing the application

Test the correct function of the application in the TIA Portal via a corresponding user program.
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4.3.5.2 FB SINA_POS and telegram 111

With the function block SINA_POS, you can implement the control of a position-controlled axis. You can use this function
block with Siemens telegram 111.

Programming the control

Fig. 6: Function block SINA_POS

For communication with the drive controller, you need the hardware identifier of the standard telegram hardware
submodule on the controller side. The hardware identifier, 267 in this example, is displayed in the Inspector window >
System constants tab if you mark the standard telegram in the device overview of the workspace.

Store the address for the inputs HWIDSTW (transmitting side from controller view) and HWIDZSW (receiving side from
controller view).

Input Data type Required value

HWIDSTW HW_IO Hardware identifier of the standard telegram hardware submodule

HWIDZSW HW_IO Hardware identifier of the standard telegram hardware submodule

Tab. 11: Function block SINA_SPEED: Required values

For further information about the control of the function block, see the DriveLib documentation from Siemens.

Testing the application

Test the correct function of the application in the TIA Portal via a corresponding user program or via the interface of the
function block SINA_POS.
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4.3.5.3 TO_SpeedAxis and standard telegram 1, 2 or 3

With the technology object TO_SpeedAxis, you can implement the control of a speed-controlled axis. You can use this
technology object with the standard telegrams 1, 2 or 3.

Parameterizing the control

ü You have added the technology object to your controller in TIA Portal.

1. Project tree > Devices tab:
Navigate to the technology object of the relevant drive controller.

ð Switch to the Function view via the configuration of the technology object.

2. In the area navigation, select Hardware interface > Drive.
Drive type: Select PROFIdrive.
Data connection: Select Drive.
Drive: Select the drive with the hardware submodule that is already inserted.

3. In the area navigation, select Hardware interface > Data exchange with the drive.
Drive data area:
Drive telegram: Select the standard telegram that corresponds to the telegram of the inserted hardware module.
Reference speed: Enter the reference speed for the set speed value. The reference speed must match parameter
M571 on the drive controller side. Note the different units on the drive controller and controller sides.
Maximum speed: Enter the maximum permitted speed. This must match or be smaller than parameter I10 on the
drive controller side. Note the different units on the drive controller and controller sides.
Additional data area:
These functions are currently not supported.

4. In the area navigation, select Extended Parameters > Limits > Dynamic limits.
Implement the settings necessary for your application.
Maximum velocity: Enter the maximum permitted velocity. This must match or be smaller than parameter I10 on the
drive controller side.
Maximum acceleration: Enter the maximum permitted acceleration. This must match or be smaller than parameter
I11 on the drive controller side.
Maximum deceleration: Enter the maximum permitted delay. This must match or be smaller than parameter I11 on
the drive controller side.



STÖBER 4 | Commissioning
03

/2
02

2 
| 

ID
 4

43
27

0.
01

43

Programming the control

The technology object is controlled via the PLCopen blocks MC_Power, MC_Halt, MC_Reset and MC_MoveVelocity:

Fig. 7: PLCopen block MC_Power

Fig. 8: PLCopen block MC_Halt

Fig. 9: PLCopen block MC_Reset
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Fig. 10: PLCopen block MC_MoveVelocity

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.

Testing the application

Test the correct function of the application in TIA Portal via a user program using PLCopen programming for technology
objects.

For commissioning, you can check the axis functionality via the axis control panel of the technology object (Project tree >
Devices tab > Technology object of the relevant controller > Commissioning).

For diagnostics, you can check status and error bits, the status of the movement as well as the PROFIdrive telegram (Project
tree > Devices tab > Technology object of the relevant controller > Diagnostics).
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4.3.5.4 TO_PositioningAxis, TO SynchronousAxis and standard telegram 3

With the technology objects TO_PositioningAxis and TO_SynchronousAxis, you can implement the control of a position-
controlled axis. TO_SynchonousAxis includes all functions of TO_PositioningAxis, but slave axes can follow the movements
of a master axis. You can use both technology objects with standard telegram 3.

From the perspective of the drive, the parameterization of the technology objects is identical.

Parameterizing the control

ü You have added the technology object to your controller in TIA Portal.

1. Project tree > Devices tab:
Navigate to the technology object of the relevant drive controller.

ð Switch to the Function view via the configuration of the technology object.

2. In the area navigation, select Basic parameters.
Set the basic parameters according to your requirements. These basic parameters are independent of the
parameterization in the drive controller.
Name: Enter the name to be used for the axis assignment at the PLCopen blocks.

3. In the area navigation, select Hardware interface > Drive.
Drive type: Select PROFIdrive.
Data connection: Select Drive.
Drive: Select the drive with the hardware submodule that is already inserted.

4. In the area navigation, select Hardware interface > Encoder.
Data connection: Select Encoder.
Encoder: Select the drive with the hardware submodule already inserted, as this contains the required encoder data.
Encoder type: Select the type of encoder connected to the drive controller. If an absolute encoder is connected to the
drive controller, select Absolute. If, on the other hand, an incremental encoder is connected, select Incremental.

5. In the area navigation, select Hardware interface > Data exchange with the drive.
Drive data area:
Drive telegram: Select the standard telegram that corresponds to the telegram of the inserted hardware module.
Reference speed: Enter the reference speed for the set speed value. The reference speed must match parameter
M571 on the drive controller side. Note the different units on the drive controller and controller sides.
Maximum speed: Enter the maximum permitted speed. This must match or be smaller than parameter I10 on the
drive controller side. Note the different units on the drive controller and controller sides.
Additional data area:
These functions are currently not supported.

6. In the area navigation, select Hardware interface > Data exchange with encoder.
Encoder telegram: Select the telegram that corresponds to the telegram of the inserted hardware module.
Automatically accept encoder values at run time (online): Activate this option so that the technology object reads the
required values from the drive controller. If automatic readout is not supported by the controller, you must enter the
required encoder values manually (see Required encoder values [} 50]).

7. In the area navigation, select Extended Parameters > Mechanics.
Encoder mounting type: Select On motor shaft. Other options are not supported.

8. In the area navigation, select Extended Parameters > Dynamic default values.
Implement the settings necessary for your application.
Velocity: Enter the velocity. This must match or be smaller than parameter I10 on the drive controller side.
Acceleration: Enter the acceleration. This must match or be smaller than parameter I11 on the drive controller side.
Delay: Enter the delay. This must match or be smaller than parameter I11 on the drive controller side.
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9. In the area navigation, select Extended Parameters > Emergency stop.
Implement the settings necessary for your application.
Maximum velocity: Enter the maximum permitted velocity. This must match or be smaller than parameter I10 on the
drive controller side.
Emergency deceleration: Enter the quick stop deceleration. This must match or be smaller than parameter I17 on the
drive controller side.

10. In the area navigation, select Extended Parameters > Limits > Dynamic limits.
Implement the settings necessary for your application.
Maximum velocity: Enter the maximum permitted velocity. This must match or be smaller than parameter I10 on the
drive controller side.
Maximum acceleration: Enter the maximum permitted acceleration. This must match or be smaller than parameter
I11 on the drive controller side.
Maximum deceleration: Enter the maximum permitted delay. This must match or be smaller than parameter I11 on
the drive controller side.

Programming the control

The technology object is controlled via the PLCopen blocks MC_Power, MC_Halt, MC_Reset, MC_MoveVelocity, MC_Home,
MC_MoveRelative, MC_MoveAbsolute and MC_MoveJog:

Fig. 11: PLCopen block MC_Power

Fig. 12: PLCopen block MC_Halt
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Fig. 13: PLCopen block MC_Reset

Fig. 14: PLCopen block MC_MoveVelocity

Fig. 15: PLCopen block MC_Home
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Fig. 16: PLCopen block MC_MoveRelative

Fig. 17: PLCopen block MC_MoveAbsolute

Fig. 18: PLCopen block MC_MoveJog
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For the technology object SynchronousAxis, the PLCopen blocks MC_GearIn and MC_MoveSuperimposed are also available:

Fig. 19: PLCopen block MC_GearIn

Fig. 20: PLCopen block MC_MoveSuperimposed

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.

Testing the application

Test the correct function of the application in TIA Portal via a user program using PLCopen programming for technology
objects.

For commissioning, you can check the axis functionality via the axis control panel of the technology object (Project tree >
Devices tab > Technology object of the relevant controller > Commissioning).

For diagnostics, you can check status and error bits, the status of the movement as well as the PROFIdrive telegram (Project
tree > Devices tab > Technology object of the relevant controller > Diagnostics).
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4.3.5.4.1 Required encoder values

Required encoder values

If automatic readout from the drive controller is not supported on the controller side, you can take the information from
the parameter M537 Sensor format. The following table contains the required values for encoders from STOBER as an
example:

Encoder model Measuring
system

ST bit MT bit Increments per
revolution
M537[2]

Number of
revolutions

M537[5]

Bit in
Gx_XIST1
M537[3]

Bit in
Gx_XIST2
M537[4]

Resolver
2-pole

Rotational 16 1 65536 1 0 0

Inductive 2.1
ECI 1118

Rotational 18 1 262144 1 0 0

Inductive 2.2
ECI 1118-G2

Rotational 18 1 262144 1 0 0

Optical 2.1
ECN 1123

Rotational 13 1 8192 1 0 0

Optical 2.2
ECN 1123

Rotational 23 1 8388608 1 0 0

Inductive 2.2
EBI 1135

Rotational 18 16 65536 65536 3 0

Inductive 2.2
EQI 1131

Rotational 19 12 524288 4096 0 0

Inductive 3.0
EQI 1131

Rotational 19 12 524288 4096 0 0

Inductive 2.1
EQI 1130

Rotational 18 12 262144 4096 0 0

Optical 2.1
EQN 1125

Rotational 13 12 8192 4096 0 0

Optical 2.2
EQN 1135

Rotational 13 23 1048576 4096 0 0

Inductive 2.1 ECI 119
hollow shaft

Rotational 19 1 524288 1 0 0

Inductive 2.2
ECI 119-G2 hollow shaft

Rotational 19 1 524288 1 0 0

Inductive 2.2
EBI 135 hollow shaft

Rotational 19 16 65536 65536 3 0

Optical 2.1
EQN 1325

Rotational 13 12 8192 4096 0 0

Optical 2.2
EQN 1337

Rotational 25 12 1048576 4096 5 0

HIPERFACE
EKM36-0KF0A0S01

Rotational 18 12 262144 4096 0 0

HIPERFACE
EDM35-2KF0A024A

Rotational 24 12 1048576 4096 4 0

Incremental encoder
1024 inc./rev.

Rotational 10 0 4096 0 0 0

Without encoder
(Lean motor)

Rotational 16 0 65536 0 0 0

Tab. 12: Required encoder values
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4.3.5.5 TO_BasicPos and Siemens telegram 111

With the technology object TO_BasicPos, you can implement the control of a position-controlled axis. You can use this
technology object with Siemens telegram 111.

Parameterizing the control

ü You have added the technology object to your controller in TIA Portal.

1. Project tree > Devices tab:
Navigate to the technology object of the relevant drive controller.

ð Switch to the Function view via the configuration of the technology object.

2. In the area navigation, select Hardware interface > Drive.
Drive: Select the drive with the hardware submodule that is already inserted.

Programming the control

The technology object is controlled via its function block:

Fig. 21: TO_BasicPos block

For more information about the control of the block, see the documentation from Siemens or the online help in the TIA
Portal.

Testing the control

Test the correct function of the application in TIA Portal via a corresponding user program or via the interface of the block
TO_BasicPos.



4 | Commissioning STÖBER

52

03
/2

02
2 

| 
ID

 4
43

27
0.

01

4.3.6 Transmitting the configuration
Transmit the configuration of your TIA project from your PC to your controller.

ü You have fully mapped and parameterized your PROFINET network in the TIA project.

1. Project navigation > Devices tab:
Select the folder of the controller in question.

2. Select Online > Advanced download to device in the menu bar.

ð The Advanced download window opens.

3. Select target device area:
Select Show all compatible nodes and click on Start search.

ð All controllers are listed that were found in the subnet.

4. Select the controller where you would like to transfer the configuration and click on Download.

ð The Software synchronization before downloading to a device window opens.

5. Click on Continue without synchronizing.

ð The Preview download window opens.

6. Click on Download.

ð The configuration is transmitted to the selected controller and the Results of the download process window
opens.

7. Click on Finish.

ð The download process is complete; the configuration was transmitted successfully to the controller.

Information

If there is an online connection, you can identify which controller you have currently selected using Flash LED if multiple
controllers are located in the same subnet.
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5 More on PROFIdrive?
The following chapters summarize the important terms and relationships concerning the application PROFIdrive.

5.1 PROFIdrive – Concept
Depending on the selected control, you can implement drive- or controller-based applications using the PROFIdrive
application. The drive-based applications provide full motion calculation and execution in the drive. Here, the set values for
position and velocity are converted into movements accurately and precisely. Referencing and jogging are performed, like
all movements, with jerk limitation during commissioning. In controller-based applications with cyclic set value specification
by the controller, the drive controllers can also perform motion tasks independently, for example referencing and the jog
function during commissioning. The drive controllers are either networked via PROFINET or receive signals and set values
via digital hardware inputs.

5.1.1 Control
The application is based on the internationally standardized drive profile PROFIdrive for electric drives (version 4.2)
according to IEC 61800-7-303. Accordingly, the drive controller is controlled using the PROFIdrive-compliant control and
status words.

5.1.2 Application classes and telegrams
The PROFIdrive application provides you with 3 application classes in production mode.

Application class 1 (AC1)

§ Set velocity specification by a controller

§ Standard telegrams 1, 2 or 3

Application class 3 (AC3)

§ Set position specification by a controller

§ Siemens telegram 111

Application class 4 (AC4)

§ Synchronized, cyclic set velocity specification by a controller

§ Standard telegram 3

For commissioning, emergency operation and maintenance or repair work, you can use jog mode (manual operation) to
move the drive independently of the controller.

For more information, see Application classes and telegrams in detail [} 89].

5.1.3 Source for digital signals
Certain signals can be controlled by digital hardware inputs.

In DriveControlSuite, you can flexibly select the source for control signals such as limit switches and reference switches.
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5.1.4 Control panels
The control panels are special wizards in DriveControlSuite, which you can use to take control of the axis. With the help of
the control panels, you can manually release and move an axis even if the drive controller has no operating unit or is
difficult to access.

Using control panels, you can check the connection wiring, the project configuration of your physical axis model or the
parameterization of your application before you start commissioning the controller or switch to normal operation.

The following control panels are available:

§ Jog control panel is used to check the projected axis model in jog mode.

§ Control panel motion provides you with a standard set of motion commands based on PLCopen. Via the control panel,
independent of the application and fieldbus interface, you can parameterize a motion profile directly for the motion
core of the axis in order to check the basic functions of the drive controller.

Because control panels override normal operation, they can be activated only with a deactivated enable signal and should
be operated by experienced users only.

5.2 Axis model
With the help of the axis model, you map the real mechanical environment of your drive project in DriveControlSuite by
parameterizing the axis type and the arrangement of existing encoders. The parameterization of the axis model is required
for the smooth operation and easy diagnosis of your drive train.

With I05 Type of axis, you select a rotational or a translational axis model and define whether the scaling of the axis is done
using either predefined or individually configured units of measure. With I00 Position range, you parameterize either an
endless or a limited travel range. You parameterize the encoder arrangement by using B26 Motor encoder and I02 Position
encoder.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° or mm of real axis movement). The scaling of the axis
model is calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or
drift.

If your axis model is not followed by any other gear ratios, you can operate the axis with output-side motion variables
where all nominal and actual values correspond to the real axis movement.

Information

The firmware processes values for the motion variables velocity, acceleration and jerk in the data type REAL32 (floating-
point number, 32 bits). Position values are processed in the INT32 data type (integer, 32 bits) to eliminate rounding errors
and enable precise movements.

Abbreviation Meaning

M Motor

MEnc Motor encoder

PEnc Position encoder
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Rotational axis models

The following figures each show a rotational axis model consisting of a motor, a gear unit and a rotary table (endless
rotational) or a pointer (limited rotational). Rotational axis models support rotational motor encoders as well as rotational
position encoders.

M

MEnc Gear PEnc

n1

n2

Fig. 22: Endless-rotational motion: Rotary table

M

MEnc Gear PEnc

n1

n2

Fig. 23: Limited-rotational motion: Pointer

Translational axis models

The following figures each show a translational axis model consisting of a motor, gear unit, feed and conveyor belt (endless
translational) or tool slide (limited translational). Translational axis models support rotational motor encoders as well as
rotational or translational position encoders.

M

MEnc Gear PEnc

n1

n2

Feed

n

x

PEnc

Fig. 24: Endless translational motion: Conveyor belt

M

MEnc Gear PEnc

n1

n2

Feed

n

x

PEnc

Fig. 25: Limited translational motion: Tool slide
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Encoder arrangement

You parameterize the encoder arrangement by using B26 Motor encoder and I02 Position encoder. The motor encoder for
velocity control is located on the motor shaft. The position encoder for position control is located on the gear unit output. If
you use only one of the two encoders, it will be used for both velocity and position control.

Encoder Parameterization Encoder arrangement

Motor encoder B26 ≠ 0: Inactive

I02 = 0: Motor encoder
MEnc

n
n

1

2

Gear unit PEnc

M

Position encoder B26 ≠ 0: Inactive

I02 = B26
MEnc

n
n

1

2

Gear unit PEnc

M

Motor encoder & position
encoder

B26 ≠ 0: Inactive

I02 ≠ B26
MEnc

n
n

1

2

Gear unit PEnc

M
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5.3 Limit switches
Limit switches are sensors that detect when a certain position has been reached.

A distinction is made here between hardware limit switches and software limit switches. While a hardware limit switch is a
real switch (hardware), a software limit switch refers to the position limiting or position monitoring implemented in the
software.

There are hardware and software limit switches on real axes, while virtual masters only have software limit switches.

Behavior in jog mode, reaching the +/- 31 bit computing limit and simultaneous triggering of positive and negative limit
switches are special cases.

5.3.1 Real axes
There are hardware and software limit switches on real axes.

5.3.1.1 Faults

If a hardware or software limit switch is overshot, a fault is triggered.

Fault

53: Limit switch

Causes

§ 1: Hardware-Limit-Switch positive

§ 2: Hardware-Limit-Switch negative

§ 3: SW-limit switch positive

§ 4: SW-limit switch negative

§ 5: +/- 31 bit computing limit reached

§ 7: Both limit switches not connected

The fault can be acknowledged. Note that movement is only possible in the opposite direction of the limit switch, since the
direction of the triggered hardware or software limit switch is locked. A direction lock is displayed in parameter I196.
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5.3.1.2 Denial

If the axis is at a hardware limit switch (I441 or I442 = High) or if it is beyond of the software limit switch, movement is
denied in the locked direction. An active direction lock is only deactivated when the axis is again within the limit switches
for at least 1 s.

In this case, parameter I91 Error = 1: Active.

The cause is output in parameter I90. Possible causes are:

§ 1: Illegal direction

§ 2: SW-limit switch positive

§ 3: SW-limit switch negative

§ 10: Denied because position is not in circular length

§ 11: HW-limit switch positive

§ 12: HW-limit switch negative

Information

There are no software limit switches for an infinite axis, since this would contradict the nature of an infinite axis.

A movement limitation is also displayed in parameter E80:

§ If E80 = 20: Limit switch, check the parameterization and the connection of the limit switches.

§ If E80 = 15: Illegal direction, check the set values and a possible direction lock in parameter I196.

Also check I196 if the permitted direction was limited with I04.

Information

Parameter I04 is only available for infinite axes.

5.3.1.3 Hardware limit switches

Hardware limit switches apply if your sources are defined in parameters I101 and I102.

Relevant parameters

§ I101 Source positive /limit switch

§ I102 Source negative /limit switch

§ I441 Signal /HW limit switch positive

§ I442 Signal /HW limit switch negative

§ I805 Actual value HW-Limit switch positive

§ I806 Actual value HW-Limit switch negative

§ I52 Delete limit switch memory

§ I196 Direction blocking

If I441 and I442 = 0: Inactive, fault 53 is triggered with cause 7: Both limit switches not connected. Therefore, after
parameterizing I101 and I102, check whether the hardware limit switches are also connected physically.

If I101 and I102 = 2: Parameter, the fault is triggered by the control word of the application (I210). In this case, check the
controller connection.
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Passable hardware limit switches

The hardware limit switches can be passed over. It is therefore possible to use an infinite cam as a hardware limit switch.
The limit switch is detected if the signal goes to 0: Inactive (parameters I441 and I442).

If the hardware limit switch is overshot, the position at which the limit switch was detected is saved. When resetting limit
switches, the axis must have reached or passed back over this saved position before the signal is valid again.

1

4

3

2

Neg. hardware limit switch

Negative Positive
Axis reference system

Neg. hardware limit switch memory

Pos. hardware limit switch

Pos. hardware limit switch memory

I442

I806

I441

I805

Fig. 26: Hardware limit switch memory

1 Setting the memory (negative hardware limit switch) with rising edge

2 Resetting the memory (negative hardware limit switch) with falling edge

3 Setting the memory (positive hardware limit switch) with rising edge

4 Resetting the memory (positive hardware limit switch) with falling edge

Information

The passable hardware limit switch is no longer effective once the position at which the edge of the limit switch was
detected has been passed over again.

Note that the positions are not saved in non-volatile memory. This means that if the axis is beyond a passable limit switch
after activation, it must first be reset to the regular travel range.

The entire system is simpler if you do not use any passable limit switches.

During commissioning or in case of defective hardware limit switch connections, problems can arise with the saved
positions. These can be deleted with parameter I52. However, deletion only takes place if the corresponding limit switch
signal is inactive. Stored positions can also be deleted by referencing, setting a reference can be deleted using I452 or by
restarting the drive controller.

During referencing, the hardware limit switches are not evaluated as limit switches. There are referencing methods in which
the hardware limit switches are used for referencing.

Example

A positive limit switch ranges from position 100 to 120.
When moving in the positive direction, it is detected at 100.
On the return journey, due to tolerances, it can be the case that the limit switch has already been left at 101.
Despite this, position 100 must be undershot in order to leave the effective limit switch.
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5.3.1.4 Hardware limit switches when referencing

Hardware limit switches assume a special position when referencing.

Limit switch as reference switch

The hardware limit switches can be used in place of a reference switch (I30 = 2: Limit switch).

Change of direction

In other referencing types, a hardware limit switch signal leads to a change of direction. However, the signal only causes a
change if it matches the direction of travel.

If the detected hardware limit switch does not match the direction of travel (e.g. negative limit switch with positive
direction of travel), a fault is then triggered.

Example

At the start of referencing, the axis is between the reference switch and positive limit switch. The referencing direction is
positive. The axis moves in the positive direction and first encounters the positive limit switch, not the reference switch.
The axis reverses and searches for the reference switch in the other direction.

5.3.1.5 Software limit switches

Software limit switches only apply if the axis has been referenced.

Only limited axes have software limit switches (I00 = 0: Limited).

Relevant parameters

§ I50 Software stop positive

§ I51 Software stop negative

§ I196 Direction blocking

If the values defined in parameter I50 and parameter I51 are the same, the software limit switches are deactivated.

5.3.1.6 Software limit switches when referencing

Software limit switches are not evaluated when referencing.

5.3.1.7 Shutting down by the limit switch

If a limit switch is approached from the permitted travel range, a fault is immediately triggered after detecting the limit
switch edge.

If the current position is on or beyond the limit switch, a fault is only triggered again if the limit switch area has been left for
at least 1 s.
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5.3.2 Special cases
A few special cases are described below.

5.3.2.1 Behavior in jog mode

The jog behavior depends on the selected control type for jog mode (I26).

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

If you select 0: Velocity control as the control type for jog mode, a gravity-loaded vertical axis descends as soon as jog mode
is activated via the control panel, the application or the operating unit (SD6) (parameter I26).

▪ Only use the 0: Velocity control control type with axes that do not have a gravity load.

I26 = 0: Velocity control:
As soon as the axis moves to a software limit switch, a quick stop is triggered instead of a fault. As a result, the axis does not
stop precisely on the software limit switch, but shortly thereafter depending on the quick stop ramp. It can immediately be
shut down again by the software limit switch. The "incorrect" direction is locked.

I26 = 1: Position control:
The axis is braked during jog mode (with jog deceleration and jog jerk) in such a way that the axis comes to a stop shortly
before the software limit switch and does not overrun it.

5.3.2.2 Reaching the +/- 31 bit computing limit

Fault: 
53: Limit switch

Cause:
5: +/- 31 bit computing limit reached

The computing limit can be reached if, for example, so many commands follow after each other for the moving axis that the
total distance to be traveled (including decimal places) adds up to over 2^31.

5.3.2.3 Simultaneous detection of positive and negative hardware limit switches

Fault: 
53: Limit switch

Cause:
7: Both limit switches not connected

This fault is triggered if I441 and I442 are both 0: Inactive. Check whether the hardware limit switches are also connected
physically.

If I101 and I102 = 2: Parameter, the fault is triggered by the control word of the application (I210). In this case, check the
controller connection.

The fault can be acknowledged with I52.
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5.4 Referencing in AC3
When commissioning a system with a position measurement system, the relation of a measured axis to an actual axis
position must be determined.

During initial commissioning or after changes to the axis model, the actual position of the axis is unknown. A defined initial
position is necessary.
As a rule, this is either identified through a reference search or referencing setting. The associated process is referred to as
referencing.
Absolute movements can be performed only in a referenced state.

5.4.1 Referencing methods
The following table shows an overview of the possible referencing methods.

Abbreviation Meaning

S Switch

M/F Torque or force

Method Initial
movement

Zero pulse Feature

S A Negative Yes Negative limit switch

B Negative Yes Negatively positioned reference switch

C Negative – Negative limit switch

D Negative – Negatively positioned reference switch
S E Positive Yes Positive limit switch

F Positive Yes Positively positioned reference switch

G Positive – Positive limit switch

H Positive – Positively positioned reference switch
S I Positive Yes Centrally positioned reference switch

J Positive – Centrally positioned reference switch
S K Negative Yes Centrally positioned reference switch

L Negative – Centrally positioned reference switch

M Negative Yes Zero pulse

N Positive Yes Zero pulse

O – – Setting the reference

M/F P Positive – Torque/force stop

Q Positive Yes Torque/force stop
M/F R Negative – Torque/force stop

S Negative Yes Torque/force stop

Tab. 13: Referencing methods
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5.4.1.1 Referencing methods in detail

The following chapters show the individual referencing methods in detail.

The following abbreviations are used in the graphs on the referencing methods:

Abbreviation Meaning

ALT Alternative

LS Limit Switch

RS Reference Switch

ZP Zero Pulse

Information

For graphically representing axes, the left is the smallest and the right is the largest position value. This means a positive
movement goes to the right and a negative to the left.

The following parameters are used in the descriptions of the referencing methods:

Coordinate Name

I28 Homing torque/force limit

I29 Time homing torque/force limit

I30 Referencing type

I31 Referencing direction

I32 Referencing speed fast

I33 Referencing speed slow

I34 Reference position

I35 Referencing with zero pulse

I39 Referencing acceleration

I43 Move to reference position

I44 Reference à-coup

I53 Index search offset

I101 Source positive /limit switch

I102 Source negative /limit switch

I103 Source reference switch
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5.4.1.1.1 Referencing method A

Referencing method A determines a reference using a run to the negative limit switch and zero pulse.

LS+LS-

LS-

ZP

Preparation

1. Activate referencing method A by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 1: Negative,
I35 to 1: Active.

2. I102: 
Enter the data source for the negative limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity I33 until it reaches
the next zero pulse after leaving the limit switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.2 Referencing method B

Referencing method B determines the reference using a run to the negatively positioned reference switch and zero pulse.

RS

ZP

ALT 2

ALT 1

RS

Preparation

1. Activate referencing method B by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

5.4.1.1.3 Referencing method C

Referencing method C determines the reference using a run to the negative limit switch.

LS-

LS+LS-

Preparation

1. Activate referencing method C by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I102: 
Enter the data source for the negative limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity I33 until it leaves
the limit switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the limit switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.4 Referencing method D

Referencing method D determines the reference using a run to the negatively positioned reference switch.

RS

ALT 2

ALT 1

RS

Preparation

1. Activate referencing method D by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the positive direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.5 Referencing method E

Referencing method E determines the reference using a run to the positive limit switch and zero pulse.

LS+

ZP

LS+LS-

Preparation

1. Activate referencing method E by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 0: Positive,
I35 to 1: Active.

2. I101: 
Enter the data source for the positive limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity I33 until it reaches
the next zero pulse after leaving the limit switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.6 Referencing method F

Referencing method F determines the reference using a run to the positively positioned reference switch and zero pulse.

RS

ZP

ALT 2

ALT 1

RS

Preparation

1. Activate referencing method F by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

5.4.1.1.7 Referencing method G

Referencing method G determines the reference using a run to the positive limit switch.

LS+

LS+LS-

Preparation

1. Activate referencing method G by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I101: 
Enter the data source for the positive limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity I33 until it leaves the
limit switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the limit switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.8 Referencing method H

Referencing method H determines the reference using a run to the positively positioned reference switch.

RS

RS

ALT 2

ALT 1

Preparation

1. Activate referencing method H by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the negative direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.9 Referencing method I

Referencing method I determines the reference using a run to the centered reference switch and zero pulse.

LS+LS- RS

RS

ZP

ALT 2

ALT 1

ALT 3

LS+

Preparation

1. Activate referencing method I by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing sequences.

ü Alternative 1: Drive is positioned between the negative limit and reference switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch until the reference switch is reached.

3. Upon reaching the reference switch, the drive changes its velocity to I33 until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position I34 after leaving the reference switch and upon
reaching the next zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.10 Referencing method J

Referencing method J determines the reference using a run to the centered reference switch.

LS+LS- RS

RS

ALT 2

ALT 1

ALT 3

LS+

Preparation

1. Activate referencing method J by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing sequences.

ü Alternative 1: Drive is positioned between the negative limit and reference switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32 until it leaves the
reference switch.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. Upon reaching the positive limit switch, the drive changes its direction and continues its run until it reaches the
reference switch.

3. Upon reaching the reference switch, the drive changes its velocity to I33 until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.11 Referencing method K

Referencing method K determines the reference using a run to the centered reference switch and zero pulse.

ALT 2

ALT 1

ALT 3

RS

ZP

ALT 2

ALT 1

ALT 3

LS-

LS+LS- RS

Preparation

1. Activate referencing method K by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.

ü Alternative 1: Drive is positioned between the reference and positive limit switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.



STÖBER 5 | More on PROFIdrive?
03

/2
02

2 
| 

ID
 4

43
27

0.
01

77

ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

3. Upon reaching the reference switch, the drive changes its velocity to I33 and continues its run until it reaches the next
zero pulse after leaving the reference switch.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.12 Referencing method L

Referencing method L determines the reference using a run to the centered reference switch.

RS

ALT 2

ALT 1

ALT 3

LS-

LS+LS- RS

Preparation

1. Activate referencing method L by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.

ü Alternative 1: Drive is positioned between the reference and positive limit switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the positive direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

3. When the reference switch is reached, the drive changes its velocity to I33 and continues its run until it leaves the
reference switch again.

4. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.13 Referencing method M

This method determines the reference using a run to the zero pulse.

ZP

Preparation

1. Activate referencing method M by setting the following parameters to the specified values:
I30 to 3: Zero pulse,
I31 to 1: Negative,

2. I32, I39, I44, I34:
Define the set values necessary for the referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

3. The drive comes to a standstill with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.14 Referencing method N

Referencing method N determines the reference using a run to the zero pulse.

ZP

Preparation

1. Activate referencing method N by setting the following parameters to the specified values:
I30 to 3: Zero pulse,
I31 to 0: Positive,

2. I32, I39, I44, I34: 
Define the set values necessary for the referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

3. The drive comes to a standstill with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.15 Referencing method O

Referencing method O determines the reference by setting the reference to any position.

Preparation

1. I30: 
Activate referencing method O by setting this parameter to 5: Define home.

2. I34: 
Define the reference position.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

The current actual position is set to the value of the reference position I34.
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5.4.1.1.16 Referencing method P

Referencing method P determines the reference using a run with a torque/force stop.

Preparation

1. Activate referencing method P by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I32, I39, I44, I34: 
Define the set values necessary for the referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of the reference position I34 when the torque/force limit is reached and
the time stored in I29 has elapsed.

3. The set values are set to the value 0 with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.17 Referencing method Q

Referencing method Q determines the reference using a run with a torque/force stop and zero pulse.

ZP

Preparation

1. Activate referencing method Q by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 0: Positive,
I35 to 1: Active.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

4. I53:
Define the start of the search for the zero pulse search.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the torque/force stop and when the time stored in I29 has passed, and
continues its run with velocity I33 until it reaches the next zero pulse.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The set values are set to the value 0 with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.18 Referencing method R

Referencing method R determines the reference using a run with a torque/force stop.

Preparation

1. Activate referencing method R by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of the reference position I34 when the torque/force stop is reached and
the time stored in I29 has elapsed.

3. The set values are set to the value 0 with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.1.1.19 Referencing method S

Referencing method S determines the reference using a run with a torque/force stop and zero pulse. The run starts with a
negative initial movement.

ZP

Preparation

1. Activate referencing method S by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 1: Negative,
I35 to 1: Active.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

4. I53:
Define the start of the search for the zero pulse search

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the torque/force stop and after the time stored in I29 has passed, and continues
its run with velocity I33 until it reaches the next zero pulse.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The set values are set to the value 0 with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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5.4.2 Reference position
Depending on the referencing type I30, the actual position I80 is replaced by the reference position I34 during the
referencing event.

5.4.3 Reference retaining
STOBER offers a convenient drive-based referencing system. Depending on the encoder model used and the reference
management, different types of reference retaining (I46) are offered.

5.5 Referencing in AC1 and AC4
In application classes 1 and 4, the controller is responsible for the position of the axes and is thus responsible for
referencing the axes. Position-capable technology objects are controlled for referencing via the PLCopen block MC_Home.

Referencing Positioning axis/
Synchronous axis with
incremental encoder

Positioning axis/
Synchronous axis with

absolute encoder

External incremental
encoder

External absolute
encoder

Active referencing
(Mode = 3 or 5)

X — — —

Passive referencing
(Mode = 2, 8 or 10)

— — — —

Setting the actual
position
(Mode = 0)

X X — —

Relative displacement
of the actual position
(Mode = 1)

X X — —

Absolute encoder
adjustment
(Mode = 6, 7)

— X — —

Tab. 14: Referencing in AC1 and AC4

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.

5.6 Synchronization: Sign-of-Life
Sign-of-Life is a life counter that helps the application in the motion controller (block in the controller that controls the
movement) and the application in the drive controller monitor each other. As soon as the application in the drive controller
has synchronized to the clock of the controller, the drive controller starts sending drive controller Sign-of-Life signals 
(DO-LS). This consists of four bits in the status word ZSW2 and follows the specification of the Sign-of-Life of the controller
(C-LS). If the drive controller no longer responds correctly and on time due to a synchronization error, an alarm is triggered
in the controller. If the controller or technology object do not behave in a synchronized manner, the drive controller
triggers fault 52: Communication with cause 16: PROFINET Sign-of-Life synchronisation failed.

Information

The Sign-of-Life mechanism is only active when synchronized operation is active in application class 4 (AC4).
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5.7 Cycle times
Possible cycle times can be found in the following table.

Type Cycle times Relevant parameters

PROFINET RT fieldbus, cyclical
communication

1 ms, 2 ms, 4 ms, 8 ms Adjustable in A150

PROFINET IRT fieldbus, cyclical
communication

250 µs, 500 µs, 1 ms, 2 ms, 4 ms, 8 ms Adjustable in A150

Tab. 15: Cycle times

5.8 PROFIdrive device control
Device control is the central component of a drive. It defines the control channel from which set values are processed and
where actual values are output.

The PROFIdrive device control is based on the internationally standardized device profile PROFIdrive for electric drives. This
profile describes the control sequence of a drive controller based on a device state machine. Each device state here
represents a certain behavior that can be changed only through defined processes. These processes are assigned to
individual state transitions.

For example, device control regulates the device start-up when turning on the supply voltage, the enable state of the drive
controller, the process of a quick stop, the behavior in case of fault and the restart after a fault.

For state transitions, the device state machine must receive certain bit combinations in the control word (STW) according to
PROFIdrive. The bit combination in the status word (ZSW), however, indicates the current state of the drive controller.

5.9 General presets
The control signals are transmitted from the controller to the drive controller via fieldbus. For the start of a movement and
for the jog function, which is defined in the PROFIdrive profile, the following presets are therefore implemented in the
DriveControlSuite:

Parameter Default value

I100 Source execute 2: Parameter

I104 Source jog enable 2: Parameter

I105 Source positive jog 2: Parameter

I106 Source negativ jog 2: Parameter

Tab. 16: Presets: Source digital signals (application)

5.10 General control
In addition to the signals of the device control, which are implemented via the control word 1 (STW1, parameter M515) and
the status word 1 (ZSW1, parameter M516), a general control signal from STW1 is also used to influence the application. On
the application level, a MC_Stop is executed if bit 0 is set to the value 0. To operate the application, bit 0 must be set to the
value 1.

Bit Designation Comment

0 On Switch on voltage:
0 = inactive; 1 = active

Tab. 17: General control: Bit 0 in control word 1
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5.11 Jog
Jog is activated for all application classes and telegrams via control word 1 (M515). In control word 1, the following bits are
assigned for the jog function:

Bit Designation Comment

8 Jog 1 ON Positive jog (prerequisite: I104 = I105 = 2: Parameter):
0 = inactive; 1 = active

9 Jog 2 ON Negative jog (prerequisite: I104 = I106 = 2: Parameter):
0 = inactive; 1 = active

Tab. 18: Jog: Bit 8 + 9 in control word 1

The jog profile is defined by the following parameters:

§ I12 Jog velocity

§ I13 Jog acceleration

§ I18 Jog jerk

5.12 Application classes and telegrams in detail
The following chapters describe the application classes and telegrams in detail.

5.12.1 Telegrams and process data
Selecting a telegram determines the process data on the drive controller side that is to be transmitted. From the drive
controller's point of view, the received process data represents the receive PZD and the process data to be transmitted
represents the transmit PZD. This data consists of the following elements:

§ Receive PZD: Control words (STW) or set values

§ Transmit PZD: State words (ZSW) or actual values

The time-critical process data is exchanged cyclically.

The mapping of the process data via the telegram is specified by the controller to the drive controller in parameter M513
and displayed in parameter M512.

Standard telegrams

The standard telegrams correspond to the standardized profile PROFIdrive.

The following standard telegrams are available:

Standard telegram Application class Description

1 AC1 Set speed value 16 bit

2 AC1 Set speed value 32 bit

3 AC1, AC4 Set speed value 32 bit with 1 position encoder

Tab. 19: Standard telegrams of the PROFIdrive application
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Manufacturer-specific telegrams

The following manufacturer-specific telegrams are available:

Siemens telegram Application class Description

111 AC3 Positioning (single positioner)

Tab. 20: Manufacturer-specific telegrams of the application PROFIdrive

5.12.2 Application class 1 (standard drive)
Application class 1 (AC1) is intended for speed-controlled axes and includes speed control with an integrated profile
generator. The set values for the velocity are specified by the controller and read in the drive controller according to the
cycle time. The complete speed control takes place in the drive controller.

Application Class 1

Automation

Technology

Drive Drive Drive

Open Loop Speed Control/
Closed Loop Speed Control

Open Loop Speed Control/
Closed Loop Speed Control

Open Loop Speed Control/
Closed Loop Speed Control

Control Word + Speed
Setpoint + ...

Status Word + 
Speed Act. Val. + ...

M M MEncoder
(optional)

Encoder
(optional)

Encoder
(optional)

Fig. 27: PROFIdrive: Application class 1 (source: PROFIdrive profile)

To control application class 1, the three standard telegrams 1, 2 and 3 are defined for PROFIdrive and implemented in the
application.
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5.12.2.1 Standard telegram 1

The standard telegram 1 (set speed value 16 bit) is used in application class 1.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD Data type Name Comment

1 WORD Control word STW1 (STW1) M515
Communication object PNU 967 in
accordance with PROFIdrive

2 INT Speed setpoint A (NSOLL_A) M520
PNU 805

Tab. 21: Standard telegram 1: receive PZD

PZD Data type Name Comment

1 WORD Status word ZSW1 (ZSW1) M516
Communication object PNU 968 in
accordance with PROFIdrive

2 INT Speed actual value A (NIST_A) M522
PNU 806

Tab. 22: Standard telegram 1: transmit PZD

Input and output signals

Limit

M571

%
n

n
%

214

M571

Unfreeze ramp function generator

Enable ramp function generator

Motion
core

M522 Speed
actual value A

Control word 1, bit 5
M515

Control word 1, bit 4
M515

M520 Speed 
setpoint A

STW1, bit 6'
M515

I10

0
0

1

214

Fig. 28: Standard telegram 1: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 1 is active, the information 1: Standard telegram 1 is displayed there.

The following application-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 1 = velocity specification by Speed setpoint
(M520)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M520)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 1 = velocity specification by Speed setpoint
(M520)

Tab. 23: Standard telegram 1: Application-specific bit in control word 1

The following application-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity
(source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

13 Standstill StndStill, standstill (source: I199):
0 = inactive; 1 = active

14 Accelerate Accel, accelerated (source: I184):
0 = inactive; 1 = active

15 Decelerate Decel, delayed (source: I185):
0 = inactive; 1 = active

Tab. 24: Standard telegram 1: Application-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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5.12.2.2 Standard telegram 2

The standard telegram 2 (set speed value 32 bit) is used in application class 1.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD Data type Name Comment

1 WORD Control word STW1 (STW1) M515
Communication object PNU 967 in
accordance with PROFIdrive

2 + 3 DINT Speed setpoint B (NSOLL_B) M521
PNU 807

4 WORD Control word STW2 (STW2) M517
PNU 803

Tab. 25: Standard telegram 2: receive PZD

PZD Data type Name Comment

1 WORD Status word ZSW1 (ZSW1) M516
Communication object PNU 968 in
accordance with PROFIdrive

2 + 3 DINT Speed actual value B (NIST_B) M523
PNU 808

4 WORD Status word ZSW2 (ZSW2) M518
PNU 804

Tab. 26: Standard telegram 2: transmit PZD

Input and output signals

Limit

M571

230

%
n

n
%

230

M571

Unfreeze ramp function generator

Enable ramp function generator

Motion
core

M523 Speed
actual value B

Control word 1, bit 5
M515

Control word 1, bit 4
M515

M521 Speed 
setpoint B

STW1, bit 6
M515

I10

0
0

1

Fig. 29: Standard telegram 2: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 2 is active, the information 2: Standard telegram 2 is displayed there.

The following application-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 1 = velocity specification by Speed setpoint
(M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 1 = velocity specification by Speed setpoint
(M521)

Tab. 27: Standard telegram 2: Application-specific bit in control word 1

The following application-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity
(source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

13 Standstill StndStill, standstill (source: I199):
0 = inactive; 1 = active

14 Accelerate Accel, accelerated (source: I184):
0 = inactive; 1 = active

15 Decelerate Decel, delayed (source: I185):
0 = inactive; 1 = active

Tab. 28: Standard telegram 2: Application-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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5.12.2.3 Standard telegram 3

The standard telegram 3 (set speed value 32 bit with 1 position encoder) is used in application class 1 and 4.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD Data type Name Comment

1 WORD Control word STW1 (STW1) M515
Communication object PNU 967 in
accordance with PROFIdrive

2 + 3 DINT Speed setpoint B (NSOLL_B) M521
PNU 807

4 WORD Control word STW2 (STW2) M517
PNU 803

5 WORD Sensor 1 control word (G1_STW) M526
PNU 809

Tab. 29: Standard telegram 3: receive PZD

PZD Data type Name Comment

1 WORD Status word ZSW1 (ZSW1) M516
Communication object PNU 968 in
accordance with PROFIdrive

2 + 3 DINT Speed actual value B (NIST_B) M523
PNU 808

4 WORD Status word ZSW2 (ZSW2) M518
PNU 804

5 WORD Sensor 1 status word (G1_ZSW) M527
PNU 810

6 +7 DINT Sensor 1 position actual value 1
(G1_XIST1)

M528
PNU 811

8 + 9 DINT Sensor 1 position actual value 2
(G1_XIST2)

M529
PNU 812

Tab. 30: Standard telegram 3: transmit PZD

Input and output signals
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Fig. 30: Standard telegram 3: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 3 is active, the information 3: Standard telegram 3 is displayed there.

The following application-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 1 = velocity specification by
Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before
freeze; 1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 1 = velocity specification by
Speed setpoint (M521)

Tab. 31: Standard telegram 3: Application-specific bit in control word 1

The following application-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the
set velocity (source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

13 Standstill StndStill, standstill (source: I199):
0 = inactive; 1 = active

14 Accelerate Accel, accelerated (source: I184):
0 = inactive; 1 = active

15 Decelerate Decel, delayed (source: I185):
0 = inactive; 1 = active

Tab. 32: Standard telegram 3: Application-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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5.12.2.4 Presets in AC1

For application class 1 with standard telegram 1, 2 or 3, the following presets are implemented in DriveControlSuite:

Parameter Default value

K08 Selected operating mode 2: Velocity, torque/force

D01 Command 1: MC_MoveSpeed

D30 Source main reference value 1: Parameter G462

G461 Source external velocity 4: Parameter G460

D15 Control byte fixed acceleration value 15: Fixed acceleration value 15

D17 Control byte fixed deceleration value 15: Fixed deceleration value 15

D19 Control byte fixed jerk value 15: Fixed deceleration value 15

Tab. 33: Presets in AC1: Source digital signals (application)

The presets of the parameters D15, D17 and D19 cause the maximum values from the axis model (I11, I16) to be used for
the profile definition for acceleration, deceleration and jerk.
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5.12.3 Application class 3 (positioning mode)
Application class 3 (AC3) is intended for position-controlled axes. In application class 3, only the higher-level technological
processes run on the controller. Interpolation, position control and speed control are implemented directly in the drive. The
set value can be specified either in MDI mode (command operating mode) or in program mode (motion block operating
mode).

Application Class 3

Automation

Technology

Drive Drive

Interpolation
Position Control

Interpolation
Position Control

Positioning Ctrl. Word + ... Positioning Status Word + ...

M MEncoder Encoder

Closed Loop Speed Ctrl. Closed Loop Speed Ctrl.

Drive ResponseDrive Request

Fig. 31: PROFIdrive: Application class 3 (source: PROFIdrive profile)

To control application class 3, Siemens telegram 111 is defined for PROFIdrive and implemented in the application.
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5.12.3.1 Siemens telegram 111

Siemens telegram 111 (single positioner) is used in application class 3.

Structure

With the exception of the user-defined user area, the mapping of the process data is specified by the controller (M512,
M513).

The following tables show the structure of the telegram.

PZD Data type Name Comment

1 WORD Control word STW1 (STW1) M515
Communication object PNU 967 in
accordance with PROFIdrive

2 WORD POS_STW1 (POS_STW1) M550

3 WORD POS_STW2 (POS_STW2) M551

4 WORD Control word STW2 (STW2) M517
PNU 803

5 INT Override (OVERRIDE) M554

6 + 7 DINT MDI target position (MDI_TARPOS) M530
PNU 834

8 + 9 DINT MDI velocity (MDI_VELOCITY) M531
PNU 835

10 INT MDI acceleration (MDI_ACC) M532
PNU 836

11 INT MDI deceleration (MDI_DEC) M533
PNU 837

12 WORD/INT User —

Tab. 34: Siemens telegram 111: receive PZD

PZD Data type Name Comment

1 WORD Status word ZSW1 (ZSW1) M516
Communication object PNU 968 in
accordance with PROFIdrive

2 WORD POS_ZSW1 (POS_ZSW1) M552

3 WORD POS_ZSW2 (POS_ZSW2) M553

4 WORD Status word ZSW2 (ZSW2) M518
PNU 804

5 INT MELDW (MELDW) M557

6 + 7 DINT Position actual value A (XIST_A) M535

8 + 9 DINT Speed actual value B (NIST_B) M523
PNU 808

10 INT FAULT_Code (FAULT_Code) M555

11 INT WARN_Code (WARN_Code) M556

12 WORD/INT User Constant value 0

Tab. 35: Siemens telegram 111: transmit PZD
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Input and output signals

Motion
core

MDI start, 
bit 15
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Program submode
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1

M535 
Position actual value A

M523 
Speed actual value B

POS_STW1, bit 0 – 5
M552 POS_ZSW1

POS_STW1, bit 0 – 5 
M550 Traversing number

M530 - M534
Manual data MDI setup,

bit 14
M550

MDI positioning

MDI startup

Manual data input submode

Control word 1,
bit 6
M515 Activate
traversing

1

0

Motion block

Fig. 32: Siemens telegram 111: Input and output signals

Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If Siemens
telegram 111 is active, there is the information 111: Telegram 111.

The following application-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Do not reject traversing task Program submode, Do not reject motion block:
0 = cancel active motion block with quick stop; 1 = active motion block is
not canceled or a new motion block can be started

5 No intermediate stop Program submode, No intermediate stop of motion block:
0 = inactive; 1 = active; 0 → 1 = interrupt active motion block by stop; 
1 → 0 = continue interrupted motion block (MC_Halt; set deceleration:
I11; set jerk: I16; prerequisite: J06 = J06); 0 → 1 = continue canceled
motion block (Continue; prerequisite: J917 = 2: Parameter)

6 Activate traversing Start movement (prerequisite: M515, bit 4 = 1, I100 = 2: Parameter):
0, 1 = inactive; 0 → 1 = active

11 Start homing procedure Start referencing, referencing type I30

Tab. 36: Siemens telegram 111: Application-specific bit in control word 1
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The following application-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 No follow error NoFlwErr, lag within tolerance (source: M598):
0 = inactive; 1 = active

10 Target position reached TargPos, target position reached (source: M596):
0 = inactive; 1 = active

11 Home position set RefPSet, in reference (source: M595):
0 = inactive; 1 = active

12 Traversing task acknowledge TrvTskAck, Execute signal is active and motion command is not finished
(source: M594):
0 = inactive; 1 = active

13 Standstill StndStill, standstill (source: I199):
0 = inactive; 1 = active

14 Accelerate Accel, accelerated (source: I184):
0 = inactive; 1 = active

15 Decelerate Decel, delayed (source: I185):
0 = inactive; 1 = active

Tab. 37: Standard telegram 111: Application-specific bit in status word 1

5.12.3.2 Operating modes in AC3

The set value in application class 3 with Siemens telegram 111 can be specified either in Program mode or in MDI mode.

The mode is specified by the controller in positioning control word 1 (POS_STW1) in parameter M550. If bit 15 is set to the
value 0, the motion block operating mode is activated at the application level. Bit 15 must be set to the value 1 for
command operating mode.

Bit Designation Comment

15 MDI start MdiStart, Specification operating mode:
0 = Program mode (motion block operating mode); 1 = MDI mode
(command operating mode)

Tab. 38: Specification operating mode: Bit 15 in positioning control word 1

The active operating mode is output in the parameter K09.

For more information on parameterizing the motion block and command operating modes in drive-based applications using
DriveControlSuite, refer to the documentation for the Drive Based application (see Further information [} 108]).

5.12.3.3 Presets in AC3

For application class 3 with Siemens telegram 111, the following presets for the Program mode are implemented in
DriveControlSuite:

Parameter Default value

J03 Source motion block selection 1: Parameter J02

Tab. 39: Presets in AC3: Source selection motion block
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5.12.4 Application class 4 (central motion control)
Application class 4 (AC4) is intended for speed-controlled axes. This application class defines a speed set value interface
with a process of speed control on the drive and position control in the controller. The position control loop is closed via the
bus. For optimal interaction, the controller and drives are synchronized via PROFINET IRT. This enables robotics and
machine tool applications with coordinated motion sequences of multiple drives.

Application Class 4

Automation

Technology

Drive Drive Drive

Closed Loop Speed Ctrl. Closed Loop Speed Ctrl. Closed Loop Speed Ctrl.

Control Word + Speed
Setpoint + ...

Status Word + 
Actual Position ...

M M MEncoder Encoder Encoder

Interpolation
Position Control

Clock Synchronous
Operation

Clock

Fig. 33: PROFIdrive: Application class 4 (source: PROFIdrive profile)

To control application class 4, standard telegram 3 is defined for PROFIdrive and implemented in the application.
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5.12.4.1 Standard telegram 3

The standard telegram 3 (set speed value 32 bit with 1 position encoder) is used in application class 1 and 4.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD Data type Name Comment

1 WORD Control word STW1 (STW1) M515
Communication object PNU 967 in
accordance with PROFIdrive

2 + 3 DINT Speed setpoint B (NSOLL_B) M521
PNU 807

4 WORD Control word STW2 (STW2) M517
PNU 803

5 WORD Sensor 1 control word (G1_STW) M526
PNU 809

Tab. 40: Standard telegram 3: receive PZD

PZD Data type Name Comment

1 WORD Status word ZSW1 (ZSW1) M516
Communication object PNU 968 in
accordance with PROFIdrive

2 + 3 DINT Speed actual value B (NIST_B) M523
PNU 808

4 WORD Status word ZSW2 (ZSW2) M518
PNU 804

5 WORD Sensor 1 status word (G1_ZSW) M527
PNU 810

6 +7 DINT Sensor 1 position actual value 1
(G1_XIST1)

M528
PNU 811

8 + 9 DINT Sensor 1 position actual value 2
(G1_XIST2)

M529
PNU 812

Tab. 41: Standard telegram 3: transmit PZD
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Fig. 34: Standard telegram 3: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 3 is active, the information 3: Standard telegram 3 is displayed there.

The following application-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 1 = velocity specification by
Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before
freeze; 1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 1 = velocity specification by
Speed setpoint (M521)

Tab. 42: Standard telegram 3: Application-specific bit in control word 1

The following application-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the
set velocity (source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

13 Standstill StndStill, standstill (source: I199):
0 = inactive; 1 = active

14 Accelerate Accel, accelerated (source: I184):
0 = inactive; 1 = active

15 Decelerate Decel, delayed (source: I185):
0 = inactive; 1 = active

Tab. 43: Standard telegram 3: Application-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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6 Appendix

6.1 Supported communication objects

6.1.1 PROFIdrive Device specific; parameter number (PNU): 0 – 899
The following table contains the supported device-specific communication objects of the standardized PROFIdrive profile
and their mapping to the corresponding parameters of STOBER.

Parameter number
(PNU)

Transmit PZD Receive PZD Name Comment

110 — — Velocity tolerance range M570

111 — — Velocity out of tolerance range
time

M597

801 ✓ ✓ Control word STW1 (STW1) M515

802 ✓ — Status word ZSW1 (ZSW1) M516

803 ✓ ✓ Control word STW2 (STW2) M517

804 ✓ — Status word ZSW2 (ZSW2) M518

805 ✓ ✓ Speed setpoint A (NSOLL_A) M520

806 ✓ — Speed actual value A (NIST_A) M522

807 ✓ ✓ Speed setpoint B (NSOLL_B) M521

808 ✓ — Speed actual value B (NIST_B) M523

809 ✓ ✓ Sensor 1 control word (G1_STW) M526

810 ✓ — Sensor 1 status word (G1_ZSW) M527

811 ✓ — Sensor 1 position actual value 1
(G1_XIST1)

M528

812 ✓ — Sensor 1 position actual value 2
(G1_XIST2)

M529

834 ✓ ✓ MDI target position (MDI_TARPOS) M530

835 ✓ ✓ MDI velocity (MDI_VELOCITY) M531

836 ✓ ✓ MDI acceleration (MDI_ACC) M532

837 ✓ ✓ MDI deceleration (MDI_DEC) M533

850 ✓ ✓ POS_STW1 M550

851 ✓ ✓ POS_STW2 M551

852 ✓ — POS_ZSW1 M552

853 ✓ — POS_ZSW2 M553

854 ✓ ✓ Override M554

855 ✓ — FAULT_Code M555

856 ✓ — WARN_Code M556

857 ✓ — MELDW M557

✓ — Position actual value A (XIST_A) M535

Tab. 44: PROFIdrive Device specific; PNU: 0 – 899
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6.1.2 PROFIdrive Profile specific; parameter number (PNU): 900 – 999
The following table contains the supported profile-specific communication objects of the standardized PROFIdrive profile
and their mapping to the corresponding parameters of STOBER.

Parameter number
(PNU)

Transmit PZD Receive PZD Name Comment

922 — — Telegram selection M513

925 — — Number of controller Sign-of-Life
failures which may be tolerated

M538

930 — — Operating mode Constant value 1

944 — — Fault message counter M540

947 — — Fault number M543

950 — — Scaling of the fault buffer Constant value 8

952 — — Fault situation counter

964 — — Drive unit identification

965 — — Profile identification number

972 — — Drive reset A09

977 — — Transfer to non-volatile memory A00

979 — — Sensor format M537

980 — — Number list of defined parameter

Tab. 45: PROFIdrive Profile specific; PNU: 900 – 999

6.1.3 PROFIdrive Velocity reference value; parameter number (PNU):
60000

The following table contains the supported Velocity reference value communication object of the standardized PROFIdrive
profile as well as its mapping to the corresponding parameter of STOBER.

Parameter number
(PNU)

Transmit PZD Receive PZD Name Comment

60000 — — Velocity reference value M571

Tab. 46: PROFIdrive Velocity reference value; PNU: 60000
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6.1.4 PROFIdrive Communication system interfaces; parameter number
(PNU): 61000 – 61999

The following table contains the supported communication objects for the transmission of the standardized PROFIdrive
profile as well as their mapping to the corresponding parameters of STOBER.

Parameter number
(PNU)

Transmit PZD Receive PZD Name Comment

61000 — — Name of station A273

61001 — — IP of station A274

61002 — — MAC of station A279

61003 — — Default gateway of station A276

61004 — — Subnet mask of station A275

Tab. 47: PROFIdrive Communication system interfaces; PNU: 61000 – 61999
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6.2 Further information
The documentation listed in the following table offers additional relevant information about the associated drive
controllers.

Current document versions can be found at http://www.stoeber.de/en/downloads/.

Device/Software Documentation Contents ID

SC6 drive controller Manual System design, technical data, project
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

442790

Multi-axis drive system with SI6
and PS6

Manual System design, technical data, project
configuration, storage, installation, connection,
commissioning, operation, service, diagnostics

442728

PROFINET communication – SC6,
SI6

Manual Installation, electrical installation, data transfer,
commissioning, detailed information

443039

SU6 safety technology – STO and
SS1 via PROFIsafe

Manual Technical data, installation, commissioning,
diagnostics

443258

SR6 safety technology – STO via
terminals

Manual Technical data, installation, commissioning,
diagnostics

442741

Drive Based (DB) application Manual Project planning, configuration,
parameterization, function test, detailed
information

442706

Additional information and sources that form the basis of this documentation or are referenced by the documentation:

PROFIBUS Nutzerorganisation e. V. (PNO), 2015. Profile Drive Technology – PROFIdrive Profile. Technical specification for
PROFIBUS and PROFINET. Specification. Version 4.2, October 2015.

Information concerning the Siemens TIA Portal

The most important information about the Siemens TIA Portal and additional documents, links and training courses can be
found at 
http://www.industry.siemens.com/topics/global/en/tia-portal/pages/default.aspx.

SC6, SI6 – Device description

A GSD file for easily integrating the drive controllers of the SC6 and SI6 series into the respective system environment can
be found in the STOBER download center http://www.stoeber.de/en/downloads/, search term GSD.

6.3 Formula symbols

Symbol Unit Explanation

F N Force

M Nm Torque

n rpm Speed

http://www.stoeber.de/en/downloads/
http://www.industry.siemens.com/topics/global/en/tia-portal/pages/default.aspx
http://www.stoeber.de/en/downloads/
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6.4 Abbreviations

Abbreviation Meaning

AC Application class

C-LS Controller life counter

DO-LS Drive controller life counter

FB Function block

GSD General Station Description data

GSDML General Station Description Markup Language

IEC International Electrotechnical Commission

IP Internet Protocol

IRT Isochronous Real-Time

LS Limit Switch

LSB Least Significant Bit

M Motor

M/F Torque or force

MAC Media Access Control

MDI Manual data input

MEnc Motor encoder

MT Multi-turn

PEnc Position encoder

PNU Parameter number

PROFIBUS Process Field Bus

PROFINET Process Field Network

PZD Process Data

RS Reference Switch

RxPZD Receive PZD (receive process data)

S Switch

ST Single-turn

STW Control word

TIA Totally Integrated Automation

TO Technology object

TxPZD Transmit PZD (transmit process data)

ZP Zero Pulse

ZSW Status word
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7 Contact

7.1 Consultation, service and address
We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:
http://www.stoeber.de/en/support

If you need our system support:
Phone +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Phone +49 7231 582-3000

Our address:
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12
75177 Pforzheim, Germany

7.2 Your opinion is important to us
We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise
productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our
documentation.
If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:
documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team

http://www.stoeber.de/en/service
http://www.stoeber.de/en/support
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7.3 Close to customers around the world
We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at
Phone +43 7613 7600-0
sales@stoeber.at

STOBER SOUTH EAST ASIA
www.stober.sg
sales@stober.sg

STOBER CHINA 
www.stoeber.cn 
Phone +86 512 5320 8850
sales@stoeber.cn

STOBER SWITZERLAND 
www.stoeber.ch 
Phone +41 56 496 96 50 
sales@stoeber.ch

STOBER FRANCE 
www.stober.fr 
Phone +33 4 78.98.91.80 
sales@stober.fr

STOBER TAIWAN 
www.stober.tw 
Phone +886 4 2358 6089 
sales@stober.tw

STOBER ITALY 
www.stober.it 
Phone +39 02 93909570 
sales@stober.it

STOBER TURKEY 
www.stober.com 
Phone +90 216 510 2290 
sales-turkey@stober.com

STOBER JAPAN 
www.stober.co.jp 
Phone +81 3 5875 7583
sales@stober.co.jp

STOBER UNITED KINGDOM 
www.stober.co.uk 
Phone +44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
Phone +1 606 759 5090 
sales@stober.com
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Glossary

Application class (AC)

Standardized drive functions according to the PROFIdrive device profile. In view of its wide range of possible
applications, six classes specified according to functionality have been defined for PROFIdrive. A drive can cover one or
more classes.

Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

Command

Operating mode in the Drive Based and Drive Based Synchronous applications. This enables configurable movements
to be shut down. The associated motion commands correspond to the PLCopen standard. An absolutely necessary,
higher-level controller coordinates the associated time-dependent sequences.

Function block

Functional software unit that includes a named copy of a data structure and associated operations defined by a
corresponding function block type.

GSD file

Includes the technical features of a PROFINET IO device (type, configuration data, parameters, diagnostic information,
etc.) in XML format in accordance with the GSDML specification. A GSD file serves as the configuration basis for project
configuration systems and is generally provided by the respective device manufacturer.

IO controller

Generally, a programmable logic controller that controls automation tasks and regulates data communication.

IO device

A decentralized field device that is assigned logically to a PROFINET IO controller that manages and controls it. An IO
device consists of multiple modules and submodules.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.

Jog

Step-by-step movement that can be used to move the drive incrementally and independently of the controller, such as
during commissioning, in emergency operation or during setup and repair work. Also: Name of a CiA 402 application
operating mode.
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MAC address

Hardware address for unique identification of a device in an Ethernet network. The MAC address is assigned by the
manufacturer and consists of a 3-byte manufacturer ID and 3-byte device ID.

Motion block

Operating mode in the Drive Based and Drive Based Synchronous applications. Summarizes the properties of
movements in the form of pre-defined motion blocks. Linking these enables the definition of complete motion
sequences, which makes it possible to execute sequences quickly – regardless of whether the motion sequences are
specified by a controller or executed through binary signals.

Process data (PZD)

Control and status information that is time-critical and transmitted in the PROFINET network cyclically using telegrams.
Depending on the view of the respective node, a distinction is made between receive PZD (RxPZD) and transmit PZD
(TxPZD).

PROFIdrive

Standardized drive interface for PROFIBUS and PROFINET open standard buses. It defines the device behavior and the
procedure for accessing internal device data for electrical drives on PROFINET and PROFIBUS. The interface is specified
by PROFIBUS and PROFINET International (PI) user organizations, and is specified as the future-proof standard by
standard IEC 61800-7-303.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.

PROFINET IO system

Bus system for industrial automation over Industrial Ethernet. The system generally consists of at least one IO
controller that controls the exchange of data with at least one IO device in a decentralized location. Within a
configurable update time, an IO controller supplies an IO device with data; the device sends data back to the IO
controller in turn. Multiple PROFINET IO systems can be operated on an Industrial Ethernet subnet simultaneously.
Two performance levels of real-time support are available with the RT transmission method for time-critical process
data and the IRT transmission method for high-precision as well as synchronized processes.

PROFINET IRT

Transmission method for high-precision as well as synchronized processes in a PROFINET IO system.

PROFINET RT

Transmission method for time-critical process data in a PROFINET IO system.

PROFIsafe

Communication standard for safety standard IEC 61508 that includes both standard as well as fail-safe communication.
The standard enables reliable communication for PROFIBUS and PROFINET open standard buses based on standard
network components, and is defined as the international standard in standard IEC 61784-3-3.
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Receive PZD (RxPZD)

Process data received by a node in the PROFINET network.

Referencing

When commissioning a system with a position measurement system, the relation of a measured axis to an actual axis
position must be determined. Usually, a defined initial position is identified either by a reference search or by a
reference setting. The associated process is referred to as referencing. Absolute movements can be performed only in
a referenced state.

Siemens telegram

Data with specified sequence and standardized contents that is exchanged cyclically between the controller and drive
controller during PROFIdrive communication. The standard telegram is structured according to the manufacturer-
specific specifications from Siemens.

Standard telegram

Data with specified sequence and standardized contents that is exchanged cyclically between the controller and drive
controller during PROFIdrive communication. The standard telegram is structured according to the PROFIdrive device
profile.

Technology object

Software object in a Siemens controller that represents a mechanical component. It encapsulates the technological
functionality and allows uniform configuration and parameterization.

Transmit PZD (TxPZD)

Process data sent by a node in the PROFINET network.
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